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About this Manual
This manual describes how to configure the system environment and setup the Interstage Business
Process Manager (Interstage BPM) Server and Console.
Note that the Interstage BPM Tenant Management Console setup is automatically performed when
you setup Interstage BPM Console.

Intended Audience
This manual is intended for Interstage BPM Super Users, who are administrators managing Interstage
BPM Server. It assumes that the reader has a working knowledge of
• Operating system administration
• Application server administration
• Database administration
• Directory Service administration

This Manual Contains
Here is a list of what is in this manual:

DescriptionTitleChapter

Description of the typical system
configurations for the setup of
Interstage BPM Server.

System Configurations for Interstage
BPM Server

1

Description of the typical system
configurations for the setup of
Interstage BPM Console.

System Configurations for Interstage
BPM Console

2

Description of the minimum
system requirements by
platform.

System Requirements for Interstage
BPM Server and Console

3

Instructions for preparing
external systems like the
database or the application
server.

Preparing for Setup of Interstage BPM
Server and Console

4

Instructions for performing setup
of Interstage BPM Server and
Console.

Setting-up Interstage BPM Server and
Console

5

Instructions for setting up your
Directory Service.

Setting Up a Directory Service6

Instructions for removing an
instance of Interstage BPM
Server and Console from the
application server

Un-setup Interstage BPM Server and
Console

7

Instructions for performing an
upgrade.

Upgrading Interstage BPM from
Previous Versions

8
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DescriptionTitleChapter

Instructions for security
implementation on Interstage
BPM.

SecurityAppendix A

Instructions for setting up
Interstage BPM Server in Solaris
containers that run on the same
physical computer.

Running Interstage Business Process
Manager in Solaris Containers

Appendix B

Instructions for setting up a
cluster of Interstage BPM
Servers.

Clustering, Load Balancing, and
Failover

Appendix C

Instructions to enable NTLM
Authentication Protocol for
Interstage BPM Console

Overview of NTLM Authentication
Protocol

Appendix D

Instructions to enable SSO
Authentication Protocol for
Interstage BPM Console

Overview of SSO AuthenticationAppendix E

Information to help you
troubleshoot problems
associated with using Interstage
BPM.

TroubleshootingAppendix F

Screenshots of the products that appear in this manual are approximations only. What you see when
using the product may differ in appearance due to platform or product version differences.

Typographical Conventions
The following conventions are used throughout this manual:

MeaningExample

Text, which you are required to type at a
command line, is identified by Courier font.

command

Text, which is visible in the user interface, is bold.screen text

Reference material is in italics.Reference

A command parameter is identified by Courier
font.

Parameter

Other References
The following references for Interstage Business Process Manager are also available:
• Release Notes

Contains an overview of Interstage Business Process Manager, setup tips, and late-breaking
information that could not make it into the manuals.

• Interstage Business Process Manager Server and Console Installation Guide
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Describes software and hardware requirements, setup procedure for Interstage Business Process
Manager Server and Console

• Interstage Business Process Manager Server Administration Guide
Explains how to configure and administrate Interstage Business Process Manager Server. This
guide also describes the configuration parameters of the Interstage BPM Server.

• Interstage Business Process Manager Developer's Guide
Describes how to use the Interstage Business Process Manager API to customize and extend
Interstage BPM to fit the unique needs of your organization.

• Interstage Business Process Manager Studio User's Guide
Explains how to model processes using the Interstage Business Process Manager Studio.

• Interstage Business Process Manager Tenant Management Console Online Help
Explains how to use the Interstage Business Process Manager Tenant Management Console
user interface.

• Interstage Business Process Manager Console Online Help
Explains how to use the Interstage Business Process Manager Console user interface.

• API Javadoc Documentation
This HTML documentation provides the API and syntax of the packages, interfaces and classes
for developing custom applications or embedding Interstage Business Process Manager into
other products.

Abbreviations
The products described in this manual are abbreviated as follows:
• "Oracle WebLogic Server" is referred to as "WebLogic Application Server" and abbreviated as

"WebLogic".
• "Interstage Business Process Manager" is abbreviated as "Interstage BPM".
• "Microsoft® Windows Server® 2008" and "Microsoft® Windows Server® 2012" are abbreviated

as "Windows Server".
• "Oracle Solaris" might be described as "Solaris", "Solaris Operating System", and "Solaris OS"

in this document.
• "Microsoft® SQL Server 2008 Standard Edition", "Microsoft® SQL Server 2008 Enterprise Edition",

"Microsoft® SQL Server 2012 Standard Edition", "Microsoft® SQL Server 2012 Business
Intelligence Edition" and "Microsoft® SQL Server 2012 Enterprise Edition" are abbreviated as
"Microsoft® SQL Server", "Microsoft SQL Server", or "SQL Server".

• "Oracle Database 11g R1 Standard Edition", "Oracle Database 11g R1 Standard Edition One",
"Oracle Database 11g R1 Enterprise Edition", "Oracle Database 11g R2 Standard Edition", "Oracle
Database 11g R2 Standard Edition One", "Oracle Database 11g R2 Enterprise Edition", "Oracle
Database 12c R1 Standard Edition", "Oracle Database 12c R1 Enterprise Edition" are abbreviated
as "Oracle".

• "Java Development Kit" and "Java SE Development Kit" is abbreviated as "JDK".
• "Java Runtime Environment" and "Java SE Runtime Environment" is abbreviated as "JRE".
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Export Controls
Exportation/release of this document may require necessary procedures in accordance with the
regulations of your resident country and/or US export control laws.
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1 System Configurations for Interstage BPM Server
Interstage Business Process Manager (Interstage BPM) is a server-based workflow engine with APIs
(Application Programming Interfaces) for workflow application development.
The Interstage BPM Server runs on an application server providing load balancing and failover
capabilities, and it operates with a database, which persistently stores and maintains all process
information.
A user and group store is required to manage Interstage BPM user accounts and to expand a group
into a list of users. Depending on your choices when setting up the server, users are managed either
in Interstage BPM's local user store or in a Directory Service. Groups can be managed in Interstage
BPM's local group store, in a Directory Service or in both systems.
The Interstage BPM Server is shipped with setup script, which is used to
• Configure the database and the application server
• Setup the Interstage BPM Server and Console to the application server
The system configurations described in the next sections are typically used. The decision of the
configuration to be used depends on the desired performance of the employed systems.

1.1 Minimum Configuration: All Systems on the same
Computer
You can copy the Interstage BPM software from the product media to your machine and use the
Interstage BPM setup script to setup the Interstage BPM Server and Console into the application
server. The Interstage BPM Server is setup as EJB application and the Interstage BPM Console is
setup as WebApplication. The setup script also creates database on the machine, and if you plan
to use a remote user store, the Directory Service on the same computer.

Figure 1: All systems on the same computer

For details about the architecture of Interstage BPM, refer to the Interstage Business ProcessManager
Server Administration Guide.
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1.2 Database on Remote Computer
The following figure shows a configuration where the Interstage BPM Server and the database are
setup on separate computers.

Figure 2: Database on Remote Computer

To set up this configuration, you copy the database setup script from the Interstage BPM
Server-computer to the database server computer. And, you can use the database setup script to
create the database.
The Interstage BPM setup script can then be run from that Interstage BPM Server-computer to
configure the application server and setting up the Interstage BPM Server to the application server.
In the configuration shown above, the Directory Service is also installed on a remote computer.
However, this has no impact on the Interstage BPM setup procedure.
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2 System Configurations for Interstage BPM Console
The Interstage BPM Console is the Client that connects to the Interstage BPM Server.
The Interstage BPM Console must run on the same application server on the same machine as the
Interstage BPM Server to which it connects.

2.1 Minimum Configuration: All Systems on the same
Computer
Interstage BPM Server and Console is always setup together on the same computer.

Figure 3: All systems on the same computer

For details about the architecture of the Interstage BPM Server, refer to the Interstage Business
Process Manager Server Administration Guide .
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3 System Requirements for Interstage BPM Server
and Console

3.1 Hardware Requirements for Interstage BPM Server and
Console

Machine and Processor

ProcessorMachineOperating
System

Minimum: Intel® Xeon® processor,
2GHz, 2 Core or greater

Fujitsu PRIMERGY or other Intel
Architecture servers

Windows

Minimum: SPARC64 V (kernel arch:
sun4u/sun4us/sun4d) processor, 1.1
GHz, 2 Core or greater

Fujitsu PRIMEPOWER or other Solaris
servers

Solaris

Minimum: Intel® Xeon® processor,
2GHz, 2 Core or greater

Fujitsu PRIMERGY or other Intel
Architecture server

Linux

Memory
Minimum: 2 GB

Hard Drive
Interstage BPM setup: 300 MB
Database server installation: Please refer to the product documentation.
Database space: The amount of database space required depends upon your business situation.
Please contact your Local Fujitsu Support Organization for more information about the estimation.

3.2 Minimum Software Requirements for Server and Console
For software requirements for the server, refer to the Interstage BPM Server Release Notes.
For software requirements for the Console, refer to the Interstage BPM Console Release Notes.

3.3 MinimumSoftware Requirements forWebBrowser Clients
For software requirements for the client machines connecting to the Console remotely, refer to the
Release Notes.
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4 Preparing for Setup of Interstage BPM Server and
Console
This chapter explains how to set up your environment before executing setup of Interstage BPM.

4.1 Database Server Preparation
This section provides instructions in configuring your database software for use by Interstage BPM.
You must create a new database instance for Interstage BPM. When setting up the Interstage BPM
Server and Console, you will specify this instance. These instructions use the default database
instance for the purpose of providing an example.

4.1.1 Configuring Microsoft® SQL Server
Prerequisites: Microsoft SQL Server is installed.
To configure Microsoft SQL Server:
1. Change SQL Server Authentication

a) Interstage BPM only supports SQL Server Authentication. To enable this, install Microsoft®
SQL Server by Mixed Mode in Authentication Mode.

If Microsoft® SQL Server is already installed, you may have to run a configuration program
such asSQLServer ConfigurationManager if the default selection from the prior installation
enabled Named Pipes. Run the SQL Server Configuration Manager and add TCP/IP.
However, do not disable Named Pipes. Both must be selected.

Note:

2. Configure the network for SQL Server
a) Confirm that TCP/IP is selected under Network Operations.
b) Determine the port number of the Microsoft® SQL Server instance that Interstage BPM will

connect to. To do so:
1. Select Start > Programs > Microsoft SQL Server <version> > Configuration Tools >

SQL Server Configuration Manager.
2. Navigate to SQL Server Network Configuration > Protocols for <MSSQLInstance>.

For the default instance, the value of <MSSQLInstance> is MSSQLSERVER.
3. Confirm that TCP/IP is enabled. Then, go to the TCP/IP properties and click the IP

Addresses tab. The IPAll section displays the TCP port and TCP Dynamic Ports
parameters.

4. If you are using the default Microsoft® SQL Server instance, note down the value of TCP
Port. If you are using a named instance, note down the value of the TCP Dynamic Ports.
You will need to specify the port number later when setting up the Interstage BPM Server.

3. Confirm Collation settings.
The default Collation settings at the time of installing Microsoft SQL are usually correct.
a) Use the following query to confirm the collation of your database case-insensitive:

SELECT convert(varchar(100), SERVERPROPERTY ('COLLATION')) as Collation

Please change the collation of the server if it is not case insensitive (collation including 'CI').
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If you have changed the CaseSensitivity parameter to CS for the server level collation, you
cannot create database via the setup script. In such a case, you need to first create Interstage
BPM database using the database creation script, and change the database collation to
CaseSensitive.
ALTER DATABASE teamflowdb COLLATE <collationName>

where <collationName> is the name of the collation, example, Latin1_General_CI_AS.
Ensure this is case-insensitive, that is, it contains the 'CI' characters.
Then you need to select the Use existing database option in the setup.config file.

Note:

4. Install the SQL Server Driver for JDBC.
You need to copy the required Microsoft SQL Server JDBC driver files from Microsoft SQL Server
WebSite to the application server computer. You will need to specify the driver location later when
setting up the Interstage BPM Server. For the exact version of the JDBC driver supported, refer
the Release Notes. If you are running your database on a remote computer, you need to copy
the required jdbc driver files to the application server computer.
In case of UNIX environments you need to confirm whether the 'read' permissions are provided
for the JDBC driver jar files.

4.1.2 Configuring Oracle
Prerequisite: Oracle is installed.

To configure Oracle for Interstage BPM:
1. Set the ORACLE_HOME environment variable to the installation directory of the database server

you are setting up on.
• Example on Oracle 11g:

ORACLE_HOME=/opt/Oracle/Oracle11gR2/product/11.2.0/dbhome_1; export ORACLE_HOME

• Example on Oracle 12c:
ORACLE_HOME=/home/oracle/app/oracle/product/12.1.0/dbhome_1; export ORACLE_HOME

2. Create a new database instance for Interstage BPM.
When setting up the Interstage BPM Server, you will specify this instance. The default database
instance for Oracle is ORCL.
Make sure that the database instance is created with the following character sets:
• AL32UTF8 as the database character set
• AL16UTF16 as the national character set
These settings are required to support Unicode UTF-16 characters.

If you use Oracle 12c, don't create the database instance as Container Database.Note:

3. Make sure that a TCP/IP version of Oracle's SQL*Net is installed.
The Oracle JDBC driver requires a TCP/IP version of Oracle's SQL*Net. This is the default for a
standard installation.

If you need to uninstall Oracle or require recovery from a failed installation, contact Oracle
Technical Support for instructions before reinstalling.

Note:
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4. Install the Oracle Driver for JDBC.
a) You need to copy the required Oracle JDBC driver files from Oracle WebSite to the application

server computer. You will need to specify the driver location later when setting up the Interstage
BPM Server. For the exact version of the JDBC driver supported, refer the Release Notes. If
you are running your database on a remote computer, you need to copy the required jdbc
driver files to the application server computer.

b) In case of UNIX environments you need to confirm whether the 'read' permissions are provided
for the JDBC driver jar files.

4.1.3 Starting the Database Server
Since configuration information must be written to the database during setup, ensure that the database
server is running prior to setting up Interstage BPM Server. Start the database server according to
the documentation provided with your database server.

4.2 Application Server Preparation

4.2.1 How to configure aWebLogic Domain for the Interstage BPMServer
Prerequisite: You have installed the WebLogic Application Server.

Configuring a WebLogic Domain for the Interstage BPM Server
To create a WebLogic domain for Interstage BPM:
1. Start the WebLogic Domain Configuration Wizard as follows:

• On Windows:
• For WebLogic 10.3.2 or WebLogic 12.1.1, do either of the following:

• Select Start > All Programs > Oracle WebLogic > Weblogic Server <version> >
Tools > Configuration Wizard.

• Run the config.cmd script located in the <MW_HOME>/wlserver_<version>/common/bin
directory.

• For Weblogic 12.1.3 and above, do either of the following:
• Select Start > All Programs > Oracle > Configuration Wizard.
• Run the config.cmd script located in the

<MW_HOME>/wlserver/oracle_common/common/bin directory.

• On UNIX:
• For WebLogic 10.3.2 or WebLogic 12.1.1, do the following:

• Run the config.sh script located in the <MW_HOME>/wlserver_<version>/common/bin
directory.

• For WebLogic 12.1.3 and above, do the following:
• Run the config.sh script located in the

<MW_HOME>/wlserver/oracle_commmon/common/bin directory.

The Welcome page appears.

Interstage BPM Server and Console Installation Guide (WebLogic Server) 17

4: Preparing for Setup of Interstage BPM Server and Console



2. Follow the instructions on the configuration wizard to create a new domain. When following the
configuration wizard, make sure of the following:
• When selecting the Java to be used, make sure you use the java specified in Interstage BPM

Server Release Notes
• In the following screen, do not select any of the checkboxes.

• For Weblogic 10.3.2 or WebLogic 12.1.1: Select Optional Configuration
• For Weblogic 12.1.3 and above: Advanced Configuration

3. When your domain creation is completed, check the Start Admin Server checkbox and click
Done.

When your Admin Server appears, you are ready to setup the Interstage BPM.

4.2.2 Configuring WebLogic Domain Security for Interstage BPM Server

Special WebLogic Server Configurations to Enable Web Service Operations
The instructions in this topic are needed if you want to perform the following operations:
• Download or upload process definitions from remote Interstage BPM Servers. This operation is

used by Interstage BPM Studio also.
• Run remote subprocesses using SWAP (Simple Workflow Access Protocol) or ASAP

(Asynchronous Service Access Protocol).
• Call Web Services from process definitions without specifying an endpoint URL.
To enable the listed Web Services Operations :
1. Stop the WebLogic Administration Server and Interstage BPM Server in which the Console is

running.
2. Add the following tag block as the last block in the <MW_HOME>/user_projects/domains/<Domain

Name>/config/config.xml file on WebLogic, for the WebLogic Server Domain in which the
Interstage BPM Console is setup:
<enforce-valid-basic-auth-credentials>false</enforce-valid-basic-auth-credentials>

For example:

...
<enforce-valid-basic-auth-credentials>false</enforce-valid-basic-auth-credentials>

</security-configuration>

3. Save the changes you have made to this file.
4. Start the WebLogic Administration Server and Interstage BPM Server in which the Console is

configured.

The WebLogic configuration change described in these instructions effectively "turns off" WebLogic
authentication. For Interstage BPM purposes, WebLogic authentication is unnecessary because the
Console authenticates its users.

Interstage BPM Server and Console Installation Guide (WebLogic Server) 18

4: Preparing for Setup of Interstage BPM Server and Console



Configuring WebLogic's Embedded LDAP Server
WebLogic Application Server comes with an embedded LDAP Server. You need to configure
WebLogic's embedded LDAP Server if any of the following applies:
• You are using Interstage BPM Studio.
• You want to run remote subprocesses using SWAP (Simple Workflow Access Protocol) or ASAP

(Asynchronous Service Access Protocol).
• You want to call Web Services from process definitions without specifying an endpoint URL.
To configure the embedded LDAP Server, do one of the following:
• Configure the Directory Service that you are using as an authentication provider for the embedded

LDAP Server.
• Add the required users manually to the embedded LDAP Server.

If you want to run remote subprocesses, you need to add the owner of the parent process definition.
If you want to call Interstage BPM Web Services from process definitions without specifying an
endpoint URL, you need to add the Interstage BPM Administrator account. This is the account
that you defined during the setup of Interstage BPM Server.

For detailed instructions on how to configure the embedded LDAP Server, refer to the WebLogic
Application Server documentation.

4.2.3 Starting WebLogic Administration Server
Before setting up Interstage BPM Server or Console, make sure that the WebLogic Administration
Server is running.
To start the WebLogic Administration Server:
1. If using Microsoft® SQL Server as database, modify the setDomainEnv scripts located at following

location to include Microsoft® SQL Server jar in front of classpath:
<MW_HOME>/user_projects/domains/<Domain Name>/bin

For below example, add the following at the end of setDomainEnv script.
For Windows:

@REM ADD EXTENSIONS TO CLASSPATHS
set DB_CLASSPATH=D:\sqljdbc4.jar
set CLASSPATH=%DB_CLASSPATH%;%CLASSPATH%

For UNIX:

#ADD EXTENSIONS TO CLASSPATHS
DB_CLASSPATH=”/usr/sqljdbc4.jar”
export DB_CLASSPATH
CLASSPATH=”${DB_CLASSPATH}${CLASSPATHSEP}${CLASSPATH}”
export CLASSPATH

2. To run Interstage BPM server, it is recommended that maximum heap size of Weblogic managed
server should be atleast 768m. Modify the java heap size of Weblogic managed server in the
setDomainEnv scripts located at following location:
<MW_HOME>/user_projects/domains/<Domain Name>/bin
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For example on Windows:
• For 32-bit Operating System:

WLS_MEM_ARGS_32BIT=-Xms256m -Xmx768m

• For 64-bit Operating System:

WLS_MEM_ARGS_64BIT=-Xms256m -Xmx768m

For example on UNIX:
• For 32-bit Operating System:

WLS_MEM_ARGS_32BIT="-Xms256m -Xmx768m"
export WLS_MEM_ARGS_32BIT

• For 64-bit Operating System:

WLS_MEM_ARGS_64BIT="-Xms256m-Xmx768m"
export WLS_MEM_ARGS_64BIT

3. Run the startup script located in:
<MW_HOME>/user_projects/domains/<Domain Name>/bin

ScriptOperating System

startWebLogic.cmdWindows

startWebLogic.shUNIX

On Windows, for WebLogic V12.1.1 or earlier, you can start the server by selecting Start >
Programs > Oracle WebLogic > User Projects > <Domain Name> > Start Admin Server for
WebLogic Server Domain.

Upon successful initialization of the WebLogic Administration Server, the following message appears
near the end of the WebLogic Console Window:
<Server started in RUNNING mode>

If you run the WebLogic Administration Server as a Windows service, wait awhile after the
Windows service says that the service is running, because it takes longer for WebLogic
Administration Server to start.

Note:

4.3 Directory Server Preparation
If you use local user management system, you do not need to do this step. Local user management
system is user management function for Interstage BPM that is provided by Interstage BPM. In the
Local user management system, all of the users for Interstage BPM are created in the database.
If you want to use external directory service to manage Interstage BPM users, you need to register
LDAP Access for users before setting up Interstage BPM Server and Console. How to setup external
directory service is described in Setting Up a Directory Service on page 35.
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5 Setting-up Interstage BPM Server and Console
For Interstage BPM Server and Console, refer to System Requirements for Interstage BPM Server
and Console on page 14. Refer to the Release Notes for details on the required components
mentioned in the procedures described in this chapter.
If you want to change the Interstage BPM configuration after setup, you can do so by following the
instructions in the Interstage BPM Server Administration Guide.

5.1 Permissions Required for Setup

Permissions Required for Setup
You must have read, write and execute permissions on the setup directory of the Interstage BPM
Server and Console.

On Solaris and Linux, if you are setting up as a non-root user, Interstage BPM Server will
not be installed as a package.

Note:

5.2 Overview of the Setup Procedure
This section summarizes the steps required to setup the Interstage BPM Server and Console. The
setup procedure depends on whether the database and the application server are installed on the
same or on different computers.
To connect to a Directory Service and login to Interstage BPM, you must configure and start the
Directory Service before starting the Interstage BPM Server.

If you are upgrading from a previous version of Interstage BPM, refer Upgrading Interstage
BPM from Previous Versions on page 58.

Note:

Running the Database and Interstage BPM Server, Console on the Same
Computer
1. Prepare the database and make sure that the database server is running.

Refer to section Database Server Preparation on page 15.

2. Prepare the application server and make sure it is running.
Refer to section Application Server Preparation on page 17.

3. If you want to connect to a Directory Service, you must configure it before starting the Interstage
BPM Server.
Refer to chapter Setting Up a Directory Service on page 35.

4. Setup Interstage BPM.
For setting Interstage BPM on the same computer, refer to section Setup Database and Interstage
BPM on the Same Computer on page 22.

5. Switch on Java security.
Refer to section Switching on Java Security on page 30.

6. Start the Interstage BPM Server.
Refer to section Starting Interstage BPM Server on page 32.
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Even if you intend to setup database and Application server on the same machine, you can
use the steps below in case you want to create database and setup Interstage BPM Server
at different times on the same machine.

Note:

Running the Database and Interstage BPM Server, Console on Different
Computers
1. Prepare the database and make sure that the database server is running.

Refer to section Database Server Preparation on page 15.

2. Prepare the application server and make sure it is running.
Refer to section Application Server Preparation on page 17.

3. Copy engine directory from product media to the application server computer.
4. Setup Interstage BPM on the application server computer.

Refer to section Setup Database and Interstage BPM on the Different Computer on page 26.

5. On the database server computer, execute the database creation script. To execute the database
creation script you need to copy it from application server computer.
Refer to section Updating the database setup script on the database machine on page 27.

6. If you want to connect to a Directory Service, you must configure it before starting the Interstage
BPM Server.
Refer to chapter Setting Up a Directory Service on page 35.

7. On the application server computer, run the setup script to setup the Interstage BPM Server
and Console.
Refer to section Running the Interstage BPM Setup Script on page 24.

8. Switch on Java security.
Refer to section Switching on Java Security on page 30.

9. Start the Interstage BPM Server.
Refer to section Starting Interstage BPM Server on page 32.

5.3 SetupDatabase and InterstageBPMon the SameComputer
To setup Interstage BPM, follow these steps:
1. Copy the engine directory from product media. Refer to theCopy Interstage BPM engine directory

from Product Media on page 23.
2. Update the configuration file according to the instructions in section Updating the Interstage BPM

Configuration File on page 23.
3. Run setup script according to the instructions in section Running the Interstage BPM Setup Script

on page 24.
If any error occurs in the script execution, check the configuration file updated in step 2 and then
re-execute the setup script. However, if an error caused due to pre-exisitng components of
Interstage BPM, then you need to un-setup the Interstage BPM and again execute this setup
script. Refer to the Un-setup Interstage BPM Server and Console on page 55
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5.3.1 Copy Interstage BPM engine directory from Product Media
To copy Interstage BPM engine directory, follow these steps:
1. Create a directory on your machine where you want to setup Interstage BPM and copy the engine

directory from Interstage BPM product media to the directory created on your machine.
In case of UNIX environment, you must grant execute permissions to the script setup.sh file.

Make sure that there are no space character or special characters (such as '~', '$', '@') in
the path of directory where you are copying the engine directory.

Note:

5.3.2 Updating the Interstage BPM Configuration File
Before execution of setup script, you need to update the configuration file for the values of parameters
required to setup the Interstage BPM.
Follow these steps:
1. Open the setup.config file located in the <engine directory>/server directory in a text editor.

To edit setup.config file, use the text editor that can edit LF characters.Note:

2. Update the configuration parameters as described in the setup.config file. The parameters are
classified under following categories:

For security reasons, it is recommended that passwords should be specified from command
prompt as Command Line Parameters. For details, referRunning the Interstage BPMSetup
Script on page 24. If passwords are specified in the configuration file, the file should be
secured.

Note:

• Interstage BPM Environment Parameters: Specify the environment you have selected for
setting up the Interstage BPM. For example, specify the selected application server, database.
execution_mode_selection
This parameter specifies the mode of setup execution. Specify the value of this parameter as
0 to setup the Interstage BPM Server and Console.
database_creation_selection
This parameter specifies whether the existing database is to be used or create a new database.

• Application Server Parameters: Specify the parameters only for the application server that
you have selected for setting up the Interstage BPM.

• Database Parameters: Specify the parameters only for database that you have selected for
setting up the Interstage BPM.

• Interstage BPM System Administrator: Specify the parameters for system administrator
(Super User).

• Interstage BPM Tenant: Specify the parameters for Tenant Administrator.

If you want to use directory server to manage Interstage BPM users, refer to the section
Setting Up a Directory Service on page 35 for more information on how to setup a directory
service.

Note:

• Interstage BPM Console: Specify the parameters for Interstage BPM Console.
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Notes about Parameters of Configuration File
Read the following instructions before updating the parameters values in configuration file.
• db_jdbc_library_path: If you are setting up Interstage BPM in cluster environment, path to which

you copy the JDBC driver, must be the same on all server nodes.
• db_ibpm_password:

• For SQL Server: By default, Microsoft SQL Server enforces a password policy that prevents
users from using simple passwords. Make sure that you enter a password that meets the
password policy requirements. Otherwise, the setup will fail. For details on the password policy,
refer to the Microsoft SQL Server documentation.

• db_port:
• For SQL Server: Ensure that TCP/IP is selected under Network Operations while configuring

Microsoft SQL Server. Please refer to the section Configuring Microsoft® SQL Server on page
15.

• For Oracle: The port number is typically 1521. You can check the actual port number in the
targets.xml file located in the <ORACLE_HOME>/<hostname>_<SID>/sysman/emd directory.

• db_instance_name
• For Oracle: The connection identifier usually corresponds to the database name unless the

database name is longer than eight characters. In this case, a truncated version of the database
name is used. You can verify the actual connection identifier in the tnsnames.ora file located
in the <ORACLE_HOME>/network/admin directory.

• LDAPAccessUserID: If you have selected a Directory Service, by default, the user account
defined on this screen is also used to log into the Directory Service. If you want to use a different
user, you must change the LDAPAccessUserID and LDAPAccessUserPassword configuration
parameters of the Interstage BPM Server. Refer to the Server Administration Guide for more
information.

5.3.3 Running the Interstage BPM Setup Script
Before executing the setup script, do the following:
• Set the value of JAVA_HOME environment variable on your machine. Specify the JDK version that

is mentioned in the Interstage BPM Server Release Notes . If this parameter is left blank or set
to an incorrect value, it will cause the error.

The JDBC connection through Microsoft JDBC Driver to a Microsoft SQL server database
can not be created using JDK 1.6.0_29. Therefore, use the JDK version that is supported
by the Interstage BPM and your Application Server. For the version information, refer to the
Interstage BPM Server Release Notes.

Note:

• Make sure that the configuration file is updated properly.
•

Make sure that there are no space character or special characters (such as '~', '$', '@') in
the path of JDK.

Note:

JRE is not supported.Note:
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Execute Interstage BPM setup script:
Run the following setup script located in the <engine directory>/server directory as mentioned
below.
• For Windows: setup.bat
• For UNIX: setup.sh
Execute the setup script using the following command:
• On Windows:

setup.bat [-<option>] [<parameter name>=<value>] [<parameter
name>=<value>]...

• On UNIX:

setup.sh [-<option>] [<parameter name>=<value>] [<parameter
name>=<value>]...

Options:
• -configFilePath <Path of configuration file>: This option is used to specify the path of

configuration file located in a directory other than that of setup.bat / setup.sh.
• -onlyValidation: This option is used to execute the setup script in validation mode. If you specify

this option, only the content of the configuration file is verified but the actual setup of Interstage
BPM will not be performed.

Command Line Parameters:
All the parameters specified in the setup.config file can be specified as the command line
parameters. The error occurs if you specify any parameter that is not supported. The format of
specification is <parameter name>=<value>. You can specify multiple parameters delimited by
space character.
If you want to use space character in the value of a parameter then you need to enclose entire
<parameter name>=<value> in double quotes. For example: "DATAFILE_PATH=C:\Program
Files\Microsoft SQL Server\MSSQL11.MSSQLSERVER\MSSQL\DATA".
If you want to use special characters on your shell, you need to escape such a character at the
command line option. If you want to use un-escape character, you need to write in the setup.config
file.
In the following example, path of setup.config file is specified, and password is set to the parameter
of appserver_admin_password and db_admin_password. Also the setup script is executed in
Validation mode.
On Windows:

setup.bat -configFilePath C:\engine\server\setup.config –onlyValidation
appserver_admin_password=password db_admin_password=password

On UNIX:

setup.sh -configFilePath /opt/FJSVibpm/engine/server/setup.config
–onlyValidation
appserver_admin_password=password db_admin_password=password
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How to Confirm Successful Setup
After executing the setup, if you receive the Setup Successful message, then the setup of Interstage
BPM server and console is completed successfully and you can now proceed to the next step.
However, if you receive the Setup Failed: <error message> message, then it indicates that the
setup is failed due to some reason. You can check the cause of any errors that occur during setup
by viewing the deployment.log file, located at the following location:
• On Windows: <engine directory>\server\deployment\logs

• On UNIX: <engine directory>/server/deployment/logs

Each time you execute the setup script, the contents of deployment.log file will be
overwritten. In some cases like specifying inappropriate options, the log file might not
generated.

Note:

When setup execution fails, depending on the cause of failure you might require to execute
un-setup script. For further information, refer toUn-setup Interstage BPMServer and Console
on page 55.

Note:

5.4 Setup Database and Interstage BPM on the Different
Computer
To setup Interstage BPM, follow these steps:
1. Copy the engine directory from Interstage BPM product media. Refer to the Copy Interstage

BPM engine directory from Product Media on page 23.
2. Copy the database directory specific to database you are using. Refer to the Copy database

setup directory to database machine on page 26
3. Update and run the database setup script on the machine where database is installed according

to the instructions in section Updating the database setup script on the database machine on
page 27

4. Update the configuration parameters as described in the setup.config file. Refer to the section
Update the configuration file on Interstage BPM Server machine on page 28.

5. Run setup script according to the instructions in section Running the Interstage BPM Setup Script
on page 24.
If any error occurs in the script execution, check the configuration file updated in step 4 and then
re-execute the setup script. However, if an error caused due to pre-existing components of
Interstage BPM, then you need to un-setup the Interstage BPM and again execute this setup
script. Refer to the Un-setup Interstage BPM Server and Console on page 55.

5.4.1 Copy database setup directory to database machine
To copy database setup directory, follow these steps:
1. Copy the directory specific to database you are using from the <engine

directory>/server/deployment/dbsetup directory to the machine where database is installed.
For Example:
• For Oracle: oracle
• For Microsoft SQL Server: sqlserver
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In this directory, only shell scripts and sql scripts are included. To use these scripts, you do not
need to install Java on the database machine.

In UNIX, you must grant following permissions for the directory you just copied (for example
<engine directory>/server/deployment/dbsetup/oracle) to the user who executes
the scripts.

Note:

• Directory: 'Read', 'Write' and 'Execute' permissions.
• All files: 'Read' permission.
• All script (.sh) files: 'Execute' permission.

5.4.2 Updating the database setup script on the database machine
Prerequisite: You have prepared the database server as instructed in section Database Server
Preparation on page 15.

To use the database creation script:
1. Login to the machine where the database is installed.
2. On the database machine, navigate to the directory where you copied the script files, and edit

the following parameters in the configuration file. The name of the configuration file depends on
Operating System of the database machine as mentioned below:
• For Windows: config.bat
• For UNIX: config.sh

Note: • When editing parameters, do not include values in double-quotes. An example of the
correct way to specify a value:
DATAFILE_PATH=C:\Program Files\Microsoft SQL
Server\MSSQL11.MSSQLSERVER\MSSQL\DATA.

• For security reasons, the password specified in the configuration file should be secured.

• Parameters common to all databases:
• USER

Database User Name
Sample value: ibpmuser

• PASSWORD
Database User Password

• For Oracle:
• SID

Oracle System ID
Sample value: orcl

• SYSTEM_PASSWORD
System User Password

• ORACLE_HOME
ORACLE home directory
Sample value on Windows: C:\app\oracle\product\11.2.0\dbhome_1
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Sample value on UNIX: /opt/app/oracle/product/11.2.0/dbhome_1

• DATAFILE_PATH
Path to store data files
Sample value on Windows: C:\app\oracle\oradata\orc1
Sample value on UNIX: /opt/app/oracle/oradata/orcl

• For SQL Server:
• ADMIN_USER

Database Administrator User
Sample value: sa

• ADMIN_PASSWORD
Database Administrator Password

• PORT
Database Port Number
Sample value: 1433

• SQLSERVER_HOME
SQLSERVER home directory
Sample value on Windows: C:\Program Files\Microsoft SQL Server

• DATAFILE_PATH
Path to store data files
Sample value on SQL Server 2008: C:\Program Files\Microsoft SQL
Server\MSSQL10.MSSQLSERVER\MSSQL\DATA.

Sample value on SQL Server 2012: C:\Program Files\Microsoft SQL
Server\MSSQL11.MSSQLSERVER\MSSQL\DATA.

3. Run the setup script. The name of the setup script depends on Operating System of the database
machine as mentioned below:
• For Windows: dbsetup.bat
• For UNIX: dbsetup.sh

Running these scripts causes the older database to be deleted. So, when you run these
scripts for the first time and if database does not exist on the machine, you will receive an
error message saying database deletion failed. This is correct behavior.

Note:

If you create database using the database creation script, validation is not performed by
the Setup Script. Therefore you need to confirm all of the preparation requirements described
in section Database Server Preparation on page 15.

Note:

5.4.3 Update the configuration file on Interstage BPM Server machine
Before executing the setup script, do the following:

To update the configuration file on Interstage BPM Server machine:
1. Open the setup.config file located in the <engine directory>/server directory in a text editor.
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You can change the file name and location of these configuration files. The updated file
name and location will need to be specified in the setup script in next step. For example,
here we use setup.config as the configuration file name.

Note:

2. Update the configuration parameters as described in the setup.config file. The parameters are
classified under following categories:

For security reasons, it is recommended that passwords should be specified from command
prompt as Command Line Parameters. For details, referRunning the Interstage BPMSetup
Script on page 24. If passwords are specified in the configuration file, the file should be
secured.

Note:

• Interstage BPM Environment Parameters: Specify the environment you have selected for
setting up the Interstage BPM. For example specify the selected application server, database.
execution_mode_selection
This parameter specify the mode of setup execution. Specify the value of this parameter as
0 to setup the Interstage BPM Server and Console.
Database_creation_selection
This parameter specify whether the existing database is to be used or create a new database.
Specify the value of this parameter as 1 as the existing database is to be used.

• Application Server Parameters: Specify the parameters only for the application server that
you have selected for setting up the Interstage BPM.

• Database Parameters: Specify the parameters only for database that you have selected for
setting up the Interstage BPM.

• Interstage BPM System Administrator: Specify the parameters for system administrator
(Super User).

• Interstage BPM Tenant: Specify the parameters for Tenant Administrator.

If you want to use directory server to manage Interstage BPM users, refer to the section
Setting Up a Directory Service on page 35 for more information on how to setup a directory
service.

Note:

• Interstage BPM Console: Specify the parameters for Interstage BPM Console.

5.5 User Accounts and Groups
Every user that is to work with Interstage BPM needs a user account and must be assigned to one
or more groups.

To create user accounts and groups that are valid for Interstage BPM, use only alphanumeric
characters, hyphens, and underscore characters ("_"). User names and group names must
not begin with an at character ("@") as this is used to identify Agents in Interstage BPM.

Note:

Interstage BPM administrator accounts must be members of a special group named by default
AdminRole.
If you have configured the Interstage BPM Server to use a Directory Service, you need to configure
the Directory Service before starting the Interstage BPM Server. For details, refer to chapter Setting
Up a Directory Service on page 35.
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If you have configured the Interstage BPM Server to use its local user store, the Interstage BPM
Super User account has already been created in the user store. There is no need to perform further
configuration steps before starting the Interstage BPM Server. For details on creating additional user
accounts and groups, refer to the Interstage Business Process Manager User's Guide.

5.6 Switching on Java Security
Setup script setup the Interstage BPM in SaaS mode. In SaaS mode, it is critical to ensure that each
tenant has access to only their own resources, and no other tenant's resources. To achieve this
security, you need to manually switch on Java security. If you use only the default tenant or you don't
need to achieve the security, you don't have to switch on Java security.
The tenant resources to be uploaded to server are stored to the directory corresponding to tenant
name in <engine directory>. Without switching on Java security, there is no limitation to access
to external resources from a custom JavaAction or a Java class of agent. In this case, you can access
to any resource and execute it.
With switching on Java security, the permissions enable access restrictions by using the custom
class loader of Interstage BPM. If lacking for execution permissions by default to perform a workflow
application, you can add the lacking permissions by editing the policy.xml file to grant them.

The policy.xml file is provided by Interstage BPM itself. For details, refer to Changing
Tenant Resource Permissions in Administration Guide.

Note:

For WebLogic:
1. When you setup Interstage BPM, a policy.txt file is created at <engine

directory>/server/instance/default/resources. Confirm that the content of this policy.txt
file is as given below:

grant {
permission java.security.AllPermission;

};

2. To the startWebLogic.cmd / startWebLogic.sh file located in
<MW_HOME>/user_projects/domains/<Domain Name>/bin/, for the JAVA_OPTIONS variable,
add the following command level arguments:

-Djava.security.manager -Djava.security.policy=<Location of policy.txt>

For example:

...
%JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS%
-Dweblogic.Name=%SERVER_NAME%
-Djava.security.manager -Djava.security.policy=C:\policy.txt
%PROXY_SETTINGS% %SERVER_CLASS%
...
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3. If you intend to invoke any custom JavaActions, JavaScripts, or Agents, the following permission
needs to be added to the policy.xml file. Refer the Interstage BPM Administration Guide for
details about its location and how to edit this file.

...
<permission
className="java.io.FilePermission"
target="<WebLogic Domain

dir>\\<server>\\<ServerName>\\cache\\EJBCompilerCache\\-"
action="read,write,execute,delete"/>
<permission
className="java.io.FilePermission"
target="<WebLogic Domain dir>\\<server>\\<ServerName>\\tmp\\-"
action="read,write,execute,delete"/>
<permission
className="java.io.FilePermission"
target="<WebLogic Domain dir>\\<server>\\<ServerName>\\-"
action="read,write,execute,delete"/>

...

For example:

...
<permission
className="java.io.FilePermission"
target="D:\\Oracle\\Middleware\\user_projects\\domains\\base_domain

\\servers\\AdminServer\\cache\\EJBCompilerCache\\-"
action="read,write,execute,delete"/>
<permission
className="java.io.FilePermission"
target="D:\\Oracle\\Middleware\\user_projects\\domains\\base_domain

\\servers\\AdminServer\\tmp\\-"
action="read,write,execute,delete"/>
<permission
className="java.io.FilePermission"
target="D:\\Oracle\\Middleware\\user_projects\\domains\\base_domain

\\servers\\AdminServer\\-"
action="read,write,execute,delete"/>

...

4. Re-start Interstage BPM Server. For details, refer Starting Interstage BPM Server on page 32.

Additional Settings for Custom Adaptors
In case you intend to use Custom Directory Adapters to connect to remote server, you need to add
the following permission in the policy.xml file. Refer the Interstage BPM Administration Guide for
details about its location and how to edit this file.

...
<permission
className="java.net.SocketPermission"
target="*"
action="connect,resolve"/>
...

To reflect these changes, restart the Interstage BPM Server and Console application working on the
WebLogic server. For details, refer Starting Interstage BPM Server on page 32.
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5.7 Starting Interstage BPM Server
Prerequisites:
• If you are using a Directory Service, you must have configured that Directory Service for Interstage

BPM. For details, refer to chapter Setting Up a Directory Service on page 35.
• The WebLogic Administration Server is running.
• You have finished the setup script successfully. For details, refer Running the Interstage BPM

Setup Script on page 24.

Stop and re-start Interstage BPM Server:
1. Stop the Interstage BPM Server by running the shutdown script located in

<MW_Home>/user_projects/domains/<Domain Name>/bin:

ScriptOperating System

stopManagedWebLogic.cmd <Server Name>

Example:
stopManagedWebLogic.cmd IBPMServer

Windows

stopManagedWebLogic.sh <Server Name>

Example:
stopManagedWebLogic.sh IBPMServer

UNIX

For <Server Name>, specify the name that you defined when setting up the Interstage BPM
Server.

2. Run the startup script located in <MW_HOME>/user_projects/domains/<Domain Name>/bin with
the user who has access rights to <engine directory>(i.e. User who ran the setup script).

ScriptOperating System

run<Server Name>.cmd

Example:
runIBPMServer.cmd

Windows

run<Server Name>.sh

Example:
runIBPMServer.sh

UNIX

For <Server Name>, specify the name that you defined when setting up the Interstage BPM
Server.

3. When asked by the startup script, enter the name and password of the administrator for the
WebLogic Administration Server.
Upon successful initialization of the Interstage BPM Server, the following message appears near
the end of the Console Window:
<Server started in RUNNING mode>

Interstage BPM Server for WebLogic is now ready to use.
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5.8 Starting Interstage BPM Console and Tenant Management
Console
Prerequisites:
The WebLogic Administration Server where you have setup the Console is running.

When Interstage BPM Console setup is done on WebLogic, starting the Interstage BPM Server also
starts Interstage BPM Console and Tenant Management Console. For details of starting Interstage
BPM Server, refer section Starting Interstage BPM Server on page 32
When Interstage BPM Console setup is done on a different WebLogic domain than the Interstage
BPM Server, starting the WebLogic managed server on which Console is setup starts Interstage
BPM Console. For details, refer Interstage BPM Server Release Notes.
To access Interstage BPM Console or Tenant Management Console:
1. In a Web browser

• To access the Interstage BPM Tenant Management Console, enter the URL
http://<hostname>:<port>/console/TenantManager.page

• To access the Interstage BPM Console, enter the URL
http://<hostname>:<port>/console/<tenant_name>/

Here:
• <hostname> is the machine name of the computer upon which you have setup the Interstage

BPM Console.
• The default port is 49950.
• <tenant_name> is the name of the tenant; if you configure non-SaaS mode, this is default.
• It is recommended to use the tenant name in the URL with the same case as it has been

created with during setup. However, tenant name in the URL is not case sensitive.
The Login page appears.

2. Log on to Interstage BPM Console or Tenant Management Console.

You can now begin using Interstage BPM Console and Tenant Management Console. Refer the
Interstage BPMConsole Online Help and Interstage BPM Tenant Management Console Online Help
for details.

5.8.1 Starting Interstage BPM Mobile Application
To start Interstage BPM Mobile Application:
1. In your mobile device's Browser, open the Interstage BPM Mobile application at the following

URL: http://<hostname>:<port>/console/<tenant_name>/

The Login page appears.

2. Log on to Interstage BPM Mobile application.

You can now begin using Interstage BPM Mobile application. Refer the Interstage BPM Console
Online Help for details.

5.9 Starting Interstage BPM OpenID Provider
Prerequisites: The WebLogic Administration Server where you have setup the OpenID Provider is
running.
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When Interstage BPM OpenID Provider setup is done on WebLogic, starting the Interstage BPM
Server also starts Interstage BPM OpenID Provider. For details of starting Interstage BPM Server,
refer section Starting Interstage BPM Server on page 32.
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6 Setting Up a Directory Service
This chapter provides instructions for setting up your Directory Service.

6.1 Setting Up Microsoft® Active Directory
This section provides instructions for setting up Microsoft® Active Directory. Active Directory uses a
form of the Lightweight Directory Access Protocol (LDAP). Like all LDAP-type Directory Services,
Active Directory organizes people into Groups, and maintains a user profile with the appropriate
permissions for each user.
The Active Directory setup procedure must be performed on the domain controller for your network
by an Administrator.

6.1.1 Configuring Users and Groups for Interstage BPM with GUI of
Microsoft® Active Directory
This section explains how to configure users and groups for Interstage BPM with the GUI of Microsoft
Active Directory.
1. Create an Organizational Unit (ou) named as Groups.

This ou should also be specified in the setup.config file during Interstage BPM setup. (You can
change this value to another value.)
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) In the Console tree, right-click the required domain, select New, and click Organizational

Unit.
c) Type the name of the organizational unit (Groups).
The following are common rules for configuring users and groups for Interstage BPM:
• To create Groups that are valid for Interstage BPM, use only alphanumeric characters, hyphens,

and underscore characters ("_"). Group names must not begin with an 'at' character ("@") as
this is used to identify Agents in Interstage BPM.

2. Create an Organizational Unit (ou) named as People.
(You cannot change this value to another value.)
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) In the Console tree, right-click the required domain, select New, and click Organizational

Unit.
c) Type the name of the organizational unit (People).
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At this point, the directory tree of LDAP root looks as follows:

Figure 4: Creating Groups and People

3. Create LDAP-access user.
This user is specified as SuperUser during the setup of Interstage BPM. For example, here we
use ibpm_server1 as LDAP-access user.
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) Right-click the People object, click New, and select User.
c) Enter the new user's information for ibpm_server1 and click Next.

For the user, Active Directory requires you to provide a First name, Last name, Full name,
and User logon name. Interstage BPM requires both a user login name and password to log
in.

If you use Built-in SSO authentication, do not include any forwardslash "/" or backslash '\'
characters in the user ID that you create.

Note:

d) Enter the user's password, and click Next.
e) Confirm the adding of the new user by clicking Finish in the confirmation dialog box.

Although entering a password and confirming it are optional for Active Directory, Interstage
BPM requires a password to log in. The other fields such as E-Mail, Phone, and Fax are
not used by Interstage BPM.

Note:
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At this point, the directory tree of People looks like the following:

Figure 5: Directory Tree of People

4. Add the LDAP-access user (ibpm_server1) in the Administrators group.
a) Select Start > Settings > Control Panel > Administrative Tools > Active Directory Users

andComputers. Expand the host name and the domain name to find the peopleOrganizational
Unit.

b) Right click the user (ibpm_server1) that you want to include in the Administrators group.
c) From the popup menu that appears, select Properties, and then select the Members Of tab.
d) In the user properties (for example, ibpm_server1 Properties) dialog, check if the

Administrators group already exists in the list. If not, then follow these steps:
1. Click Add.

The Select Groups dialog appears.

2. Type group name (Administrators), and then click Check Names to verify the group
name.

3. Click OK.

e) Click OK.

5. Create the default Interstage BPM roles Role and AdminRole belonging to the Organizational
Unit Groups.
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) Right-click the Groups object, click New and then select Groups.
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c) Create the group's information for AdminRole.
d) Double-click the AdminRole object, and navigate to the Member tab.
e) Click Add, and enter ibpm_server1. Now ibpm_server1 is linked to AdminRole group.
f) Repeat these steps to create the Role group, and add ibpm_server1 to the Role group.

After normal setup using Active Directory, the default Administrator Role is assigned to a
Group called AdminRole. You can change this default name by modifying the AdminRole
parameter of the Interstage BPM Server.

Note:

6. Create the IflowUsers group belonging to the Organizational Unit Groups.
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) Right-click the Groups object, click New and then select Groups.
c) Create the group's information for IflowUsers. Also, create this object as Distribute.
d) Double-click the IflowUsers object, and navigate to the Member tab.
e) Click Add, and enter ibpm_server1.

7. Create the IflowGroups group belonging to the Organizational Unit Groups.
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) Right-click the Groups object, click New and then select Groups.
c) Create the group's information for IflowGroups. Also, create this object as Distribute.
d) Double-click the IflowGroups object, and navigate to the Member tab.
e) Click Add, and enter AdminRole.
f) Similarly, add Role to IflowGroups.
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At this point, the directory tree of Groups looks like the following:

Figure 6: Directory Tree of Groups

You have now completed the configuration for Active Directory. You can now setup Interstage BPM
with Microsoft Active Directory.

6.1.2 Using Existing Active Directory Users and Groups
If you are new to Interstage BPM and are already using Active Directory as the Directory Service to
maintain your organization's Users and Groups, you can use your existing directory structure with
Interstage BPM. You can do this by designating which of your LDAP Users and Groups you will be
able to use in Interstage BPM. This involves the modification of two special LDAP Groups, IflowUsers
and IflowGroups.
To give your LDAP Users access to Interstage BPM as Interstage BPM users, add them as members
of the IflowUsers group. You can add each user individually or add a group that contains the users.
Users in the group sub-levels will also have access permission. To use your LDAP Groups directly
in Interstage BPM add them as members of the IflowGroups group.

6.1.3 Adding New Users Using the GUI
To create users that are valid for Interstage BPM, use only alphanumeric characters,
hyphens, and underscore characters ("_"). User names must not begin with an at character
("@") as this is used to identify Agents in Interstage BPM.

Note:
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To add new users using the ActiveDirectory GUI:
1. Launch the Active Directory Console if you haven't already done so by selecting Start > Settings

> Control Panel > Administrative Tools > Active Directory Users and Computers. Expand
the host name and the domain name to find the people Organizational Unit.

2. Right click people.
3. From the popup menu, select New, and then select User to open the New Object - User dialog.

Figure 7: Adding a New User

4. Enter the new user's information and click Next.
For each user, Active Directory requires you to provide a first name, last name, full name, and
user login name.
Interstage BPM requires both a user login name and password to log in.
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5. Enter the user's password, and make sure that User must change password at next logon
check box is not selected. Click Next.

Figure 8: Adding a New User
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6. Confirm the adding of the new user by clicking Finish in the confirmation dialog.

Figure 9: Adding a New User

Use the New Object - User dialog to create as many new user profiles as you want.

7. Add the new user to IflowUsers so that the new user is recognized by Interstage BPM. To do
so:
a) In theActive Directory Users and Computerswindow, expand the host name and the domain

name to find the main Organizational Unit that you specified during Interstage BPM setup.
b) Right click the IflowUsers Group and select Properties from the popup menu.
c) Select the Members tab and click Add.

The Select Users, Contacts, Computers, or Groups dialog appears.

d) Enter the name of the new user that is to be added to IflowUsers. Click Check Names to
verify the user name.

e) Click OK.

6.1.4 Adding New Groups Using the GUI
To create Groups that are valid for Interstage BPM, use only alphanumeric characters,
hyphens, and underscore characters ("_"). Group names must not begin with an at character
("@") as this is used to identify Agents in Interstage BPM.

Note:
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To add a new Group using the GUI:
1. Launch the Active Directory Console if you haven't already done so by selecting Start > Settings

> Control Panel > Administrative Tools > Active Directory Users and Computers. Expand
the host name and the domain name to find the groups Organizational Unit.

2. Right click groups.
3. From the popup menu, select New, and then select Groups to open the New Object - Groups

dialog.
4. Add the new Group's information, and then click OK to add your new Group.

In the example below, the Group Role is added.

Figure 10: Adding New Groups

5. Confirm the adding of the new Group by clicking Finish in the confirmation dialog box.
Use the New Object - Groups dialog to create as many new user profiles as you want.
For each Group, Active Directory requires you to provide a unique name for your Group.

6. Add the new Group to IflowGroups so that the new Group is recognized by Interstage BPM. To
do so:
a) In theActive Directory Users and Computerswindow, expand the host name and the domain

name to find the main Organizational Unit that you specified during Interstage BPM setup.
b) Right click the IflowGroups Group and select Properties from the popup menu.
c) Select the Members tab and click Add.

The Select Users, Contacts, Computers, or Groups dialog appears.
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d) Enter the name of the new Group that is to be added to IflowGroups. Click Check Names
to verify the Group name.

e) Click OK.

6.1.5 Adding Members to a Group Using the GUI
To add members to a Group using the GUI:
1. Launch the Active Directory Console if you haven't already done so by selecting Start > Settings

> Control Panel > Administrative Tools > Active Directory Users and Computers. Expand
the hostname and the domain name to find the groups Organizational Unit.

2. Right click the group to which you want to add members.
3. From the popup menu that appears select Properties, and then select theMembers tab to display

the Group's properties dialog.
The Properties dialog for the group named "Role" is used in the following example. ibpm_example
is already a member of the group named "Role". It is highly recommended that you use a group
with a more meaningful name than "Role" in your own programming practice, since this name
tends to be very confusing to talk about.

Figure 11: Adding Members

4. In the Role Properties dialog, click Add.
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The Select Users, Contacts, Computers, or Groups dialog appears.

5. In Windows Server, search a user or Group that you want to add as a member of the Group.
The user or Group appears in the bottom text area of the dialog.

Figure 12: Selecting a User

6. Click OK.
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The user appears with the existing users in the Properties dialog.

Figure 13: New Member Added

7. To theAdminRoleGroup, add the IDs of all Interstage BPM users who will create WFAdminSession
objects through Java. This Group should at least include the Interstage BPM Administrator account
that you defined during setup.

6.2 Setting Up Oracle Directory Server Enterprise Edition
Oracle Directory Server Enterprise Edition uses a form of the Lightweight Directory Access Protocol
(LDAP). Like all LDAP-type Directory Services, it organizes people into Groups, and maintains a
user profile with the appropriate permissions for each user.
Prerequisite:
• Install the Oracle Directory Server Enterprise Edition and start it.
• Create suffixes on Oracle Directory Server Enterprise Edition for Interstage BPM.
• Create a Directory Server Instance.
To use Interstage BPM with Oracle Directory Server Enterprise Edition:
You must customize your Oracle Directory Server Enterprise Edition installation as follows:
• Configure users and Groups to use Interstage BPM.
• Add general users and general Groups to the Directory Service.
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6.2.1 Configuring Users and Groups for Interstage BPM with GUI of
Oracle Directory Server Enterprise Edition
This section explains how to configure users and groups for Interstage BPM with the GUI of Oracle
Directory Server Enterprise Edition.
1. Create an Organizational Unit (ou) named as Groups.

This ou should also be specified in the setup.config file during Interstage BPM setup. (You can
change this value to another value.)
a) Open the Oracle Directory Service Control Center, and select the Browse tab of Entry

Management.
b) Specify the DN that you want to use in the View DN drop-down list.
c) Click New Entry to start the New Entry wizard.
d) In the Choose Object Class screen, for Entry Type, select Organizational Unit-

(organizationalUnit).
e) In the Configure Attribute screen, enter Groups for the Organization Unit (ou).
The following are common rules for configuring users and groups for Interstage BPM:
• To create users that are valid for Interstage BPM, use only alphanumeric characters, hyphens,

and underscore characters ("_"). User IDs must not begin with an 'at' character ("@") as this
is used to identify Agents in Interstage BPM.

2. Create an Organizational Unit (ou) named as People.
(You cannot change this value to another value.)
a) In the Oracle Directory Service Control Center, select the Browse tab of Entry Management.
b) Specify the DN that you want to use in the View DN drop-down list.
c) Click New Entry to start the New Entry wizard.
d) In the Choose Object Class screen, for Entry Type, select Organizational Unit-

(organizationalUnit).
e) In the Configure Attribute screen, enter People for the Organization Unit (ou).

Although entering a password and confirming it are optional for Oracle Directory Server
Enterprise Edition, Interstage BPM requires a password to log in. The other fields such as
E-Mail, Phone, and Fax are not used by Interstage BPM.

Note:
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At this point, the directory tree of LDAP root looks as follows:

Figure 14: Creating Groups and People

3. Create LDAP-access user.
This user is specified as SuperUser during the setup of Interstage BPM. For example, here we
use ibpm_server1 as LDAP-access user.
a) In the Oracle Directory Service Control Center, select the Browse tab of Entry Management.
b) Under the People group you created earlier, click New Entry and start the New Entry wizard.
c) In the Choose Object Class screen, for Entry Type, select User - (inetOrgPerson).
d) In the Configure Attribute screen, enter ibpm_server1 for cn and sn fields of Required

Attributes.
e) In the Configure Attribute screen, enter ibpm_server1 for User ID(uid) field of Allowed

Attributes. Also enter information for Password and Confirm Password fields.

If you use Built-in SSO authentication, do not include any forwardslash "/" or backslash '\'
characters in the user ID that you create.

Note:
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At this point, the directory tree of People looks like the following:

Figure 15: Directory Tree of People

4. Create the default Interstage BPM roles Role and AdminRole belonging to the Organizational
Unit Groups.
a) In the Oracle Directory Service Control Center, select the Browse tab of Entry Management.
b) Under the Groups group you created earlier, click New Entry and start the New Entry wizard.
c) In the Choose Object Class screen, for Entry Type, select Static Group -

(groupOfUniqueNames).
d) In the Configure Attribute screen, enter AdminRole for Full Name (cn) field of Required

Attributes.
e) In the Configure Attribute screen, in Allowed Attributes, for both Groups select the default

user you created in the previous step.
f) Similar to the steps just performed for AdminRole, repeat these steps for Role.
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After a normal installation using the Oracle Directory Server Enterprise Edition, the default
Administrator Group is called AdminRole. You can change this default name by modifying
the AdminRole parameter of the Interstage BPM Server. For the parameter description,
refer the Interstage BPM Server Administration Guide. To this Group, add the IDs of all
Interstage BPM users who will access administration functions in the Interstage BPM Console
or create WFAdminSession objects through Java. This Group should at least include the
Interstage BPM Administrator account that you defined during setup (typically ibpm_server1).

Note:

5. Create the IflowUsers group belonging to the Organizational Unit Groups.
a) In the Oracle Directory Service Control Center, select the Browse tab of Entry Management.
b) Under the Groups group you created earlier, click New Entry and start the New Entry wizard.
c) In the Choose Object Class screen, for Entry Type, select 'Static Group -

(groupOfUniqueNames).
d) In the Configure Attribute screen, enter IflowUsers for Full Name (cn) field of Required

Attributes.
e) In the Configure Attribute screen, in Allowed Attributes, add ibpm_server1 for Group

Member (uniqueMember) field. By using the Add button, for both Groups select the default
user you created in step 3.

6. Create the IflowGroups group belonging to the Organizational Unit Groups.
a) In the Oracle Directory Service Control Center, select the Browse tab of Entry Management.
b) Under the Groups group you created earlier, click New Entry and start the New Entry wizard.
c) In the Choose Object Class screen, for Entry Type, select 'Static Group -

(groupOfUniqueNames).
d) In the Configure Attribute screen, enter IflowGroups for Full Name (cn) field of Required

Attributes.
e) In theConfigure Attribute screen, inAllowed Attributes, add AdminRole and Role forGroup

Member (uniqueMember) field. By using the Add button, you can select AdminRole and
Role you created in step 4.
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At this point, the directory tree of Groups looks like the following:

Figure 16: Directory Tree of Groups

7. Configure ACI.
a) In the Oracle Directory Service Control Center, select the Access Control tab of Entry

Management.
b) Click New ACI from Syntax and start the New ACI wizard.
c) Enter information for the ACI Syntax and Entry where the ACI is located.

ACI Syntax:(target = ldap:///'Suffix') (targetattr="*") (version 3.0; acl
"'ACIName'"; allow (all) (userdn = "ldap:///uid='UserId',ou=People,'Suffix'")
;)

Example:

(target = ldap:///dc=xxxx,dc=fujitsu,dc=com) (targetattr="*")
(version 3.0; acl "Enable Full access for IBPM admin user"; allow
(all)
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(userdn =
"ldap:///uid=ibpm_server1,ou=People,dc=xxxx,dc=fujitsu,dc=com") ;)

Entry where the ACI is located: Suffix
Example:

dc=xxxx,dc=fujitsu,dc=jp

You have now completed the configuration for Oracle Directory Server. You can now setup Interstage
BPM with Oracle Directory Server Enterprise Edition.

6.2.2 Using Existing Oracle Directory Server Enterprise Edition Users
and Groups
If you are new to Interstage BPM and are already using Oracle Directory Server Enterprise Edition
as the Directory Service to maintain your organization's users and Groups, you can use your existing
directory structure with Interstage BPM. You can do this by designating which LDAP Users and
Groups can be used directly within Interstage BPM. This involves the modification of two special
LDAP Groups, IflowUsers and IflowGroups.
To give your LDAP Users access to Interstage BPM add them as members of the IflowUsers Group.
You can add each user individually or add a Group that contains the users. Users in the Group
sub-levels are also given access. To use your LDAP Groups within Interstage BPM add them as
members of the IflowGroups Group.

6.2.3 Adding New Oracle Directory Server Enterprise Edition Users
When you want to add a new user as a general Interstage BPM user, you need to create a user that
belongs to ou=People.
To add a new user:
1. Open the Oracle Directory Service Control Center, and select the Browse tab of Entry

Management.
2. Under the People group, click New Entry and start the New Entry wizard.
3. In the Choose Object Class screen, for Entry Type, select User - (inetOrgPerson).
4. In the Configure Attribute screen, enter the username of the new user in the cn and sn fields

of Required Attributes.
5. In the Configure Attribute screen, enter the LDAP User ID for User ID(uid) field of Allowed

Attributes. Also enter information for Password and Confirm Password fields.

6.2.4 Adding New Groups
When you want to add new groups as general Interstage BPM group, you need to create a group
and add it to Role group.
1. Open the Oracle Directory Service Control Center, and select the Browse tab of Entry

Management.
2. Under the Groups group, click Edit Entry to start the Edit Entry wizard for the group named

"Role".
3. In the Allowed Attributes screen, add the group you want by using the Add button.
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6.3 Group Caching
When the Interstage BPM Server starts up, Interstage BPM connects to the Directory Service and
copies all of the user and Group information defined in LDAPUsersDN and LDAPGroupsDN to a cache
on the Interstage BPM Server. This increases Interstage BPM performance because user and Group
information no longer has to be retrieved from the Directory Service, which might be running on a
separate network computer. It retrieves it from the LDAP Cache that is on the local computer in
memory.
If the cache is not updated, users added since the start of the Interstage BPM Server would not be
able to login to or use Interstage BPM. To avoid this, the cache has to be updated periodically.
The LDAPGroupCacheAgeSec parameter of the Interstage BPM Server specifies how often the LDAP
Cache is updated. Groups that have been in service for longer than the period of time specified in
the LDAPGroupCacheAgeSec parameter are checked, and new user and Group information is retrieved
from the Directory Service. The default value for this parameter is 3600 seconds; that is, the LDAP
Cache will be checked every hour. If this parameter is set to -1, new user and Group information is
retrieved from the Directory Service every time it is needed. Refer to the Interstage Business Process
Manger Server Administration Guide for more information about the configuration parameters of the
Interstage BPM Server.
Each entry in the cache has a timestamp that is set to the last time that group was read from the
Directory Service. Whenever someone calls the Directory Adapter to fetch a Group, the Directory
Adapter checks if that Group is in the cache:
• If the Group requested is not in the cache, it is read in and timestamped with the current time.
• If the Group requested is already in the cache, the timestamp is checked. If the Group was

timestamped before the previous cache check (it is at a time before LDAPGroupCacheAgeSec
seconds ago), then just that Group is deleted from the LDAP Cache and read back in from the
Directory Service. All other Groups in the cache are unaffected.

6.4 User Attribute Caching
The generic structure of an Interstage BPM user's profile is stored using multiple user attributes.
These attribute values include the user's ID, email, manager or subordinate's ID, and so on. Inclusion
of manager or subordinate information in the Interstage BPM user profile allows mapping of your
company’s organization and people structure so that Interstage BPM can further use this information.
The RequiredUserAttribute property of Interstage BPM stores names of user attributes that are
necessary to be defined for a user profile.
All attributes specified for RequiredUserAttribute are not cached. Only attributes for which the
cache option is specified are cached. Storing attributes in the local database cache allows Interstage
BPM to quickly search and retrieve these attribute values for any user, from the cache. Retrieved
attribute values can further be used for different purposes (for example, directly allocating a task to
a particular user's manager or subordinate, or viewing what tasks a user’s subordinates are allocated
to).
Interstage BPM server refreshes the user attribute values in the cache in the following scenarios:
• When you modify the value of the RequiredUserAttribute Interstage BPM property
• When you call the Model API WFAdminSession.refreshAllUserProfileCache() method
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6.5 Changing Username and Password of Tenant Owner
When a tenant is created, the Tenant Owner name and password specified while creation of the
tenant are stored in Interstage BPM Server tenant properties of ServerUserName, ServerPassword
and in LDAPAccessUserID, LDAPAccessUserPassword for LDAP-related directory services.
If you change Tenant Owner name or password then please do not forget to change these Interstage
BPM Server tenant properties as well and also re-activate the tenant.
But, if you use Local User Management (LUM) as a directory service and change the Tenant Owner
password then ServerPassword will be changed automatically at the same time. In this scenario,
you need not re-activate the tenant.
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7 Un-setup Interstage BPM Server and Console
This chapter explains how to un-setup Interstage BPM Server and Console from an application
server.

7.1 Un-setup Interstage BPM Server and Console from the
Application Server
Prerequisite: The WebLogic Administration Server is running.

You can un-setup the Interstage BPM Server and Console from the application server using the
setup script.

When you un-setup the Interstage BPM Server and Console , the Interstage BPM database
will not be removed.

Note:

To un-setup an Interstage BPM Server and Console instance:
Log out of all Interstage BPM Clients and close all Browser windows.
Stop the Interstage BPM Server by running the shutdown script located in
<MW_Home>/user_projects/domains/<Domain Name>/bin:
For <Server Name>, specify the name that you defined when setting up the Interstage BPM Server.

ScriptOperating System

stopManagedWebLogic.cmd <Server Name>

Example:
stopManagedWebLogic.cmd IBPMServer

Windows

stopManagedWebLogic.sh <Server Name>

Example:
stopManagedWebLogic.sh IBPMServer

UNIX

Follow the steps described below:
1. Confirm the configuration parameters according to the sectionConfirm the Un-setup Configuration

File on page 55.
2. Run the unsetup script according to the instructions in section Running the Un-setup Script on

page 56
3. Backup your data according to the instructions in section Backup Resources on page 57
4. Remove the engine directory according to the section Remove engine Directory on page 57.

7.1.1 Confirm the Un-setup Configuration File
Make sure the configuration parameters are properly set in the unsetup.config file located at
<engine directory>/server directory. You can specify the value of parameters which are not set,
either in the unsetup.config file or using the command line parameters while executing the unsetup
script, as the value is not specified for parameter of password.

If you have set the password parameters in the configuration file, secure the file for security
reasons.

Note:
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Basically, when unsetup.config file does not exist, executing un-setup is not neccessary.
However, under certain conditions (for example - when directory from previous setup is
deleted without executing un-setup), the unsetup.config file needs to be created manually
using the following steps:

Note:

1. Use the following template located in the <engine
directory>/server/deployment/configFile/directory to create the un-setup
configuration file.
• For Windows: unsetup-template-Win.config
• For UNIX: unsetup-template-Unix.config

2. Rename the template file you used in step 1 to unsetup.config.
3. Copy unsetup.config to <engine directory>/server directory.

7.1.2 Running the Un-setup Script
To un-setup an Interstage BPM Server and Console instance:
Run the following unsetup script located in the <engine directory>/server directory as mentioned
below.
For Windows: unsetup.bat
For UNIX: unsetup.sh
Execute the setup script using the following command:
• On Windows:

unsetup.bat <parameter name>=<value> <parameter name>=<value>...

• On UNIX:

unsetup.sh <parameter name>=<value> <parameter name>=<value>...

All the parameters specified in the unsetup.config file can be specified as the command line
parameters. The error occurs if you specify any parameter that is not supported. The format of
specification is <parameter name>=<value>. You can specify multiple parameters delimited by
space character.
If you want to use space character in the value of a parameter then you need to enclose entire
<parameter name>=<value> in double quotes. For example: "DATAFILE_PATH=C:\Program
Files\Microsoft SQL Server\MSSQL11.MSSQLSERVER\MSSQL\DATA".
If you want to use special characters on your shell, you need to escape such a character at the
command line option. If you want to use un-escape character, you need to write in the
unsetup.config file.
In the following example, password is set to the parameter of appserver_admin_password and
as_message_broker_password:
On Windows:

unsetup.bat appserver_admin_password=password db_admin_password=password

On UNIX:

unsetup.sh appserver_admin_password=password db_admin_password=password
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If the administrative security mode is enabled and you run the unsetup script, a dialog box
appears with prompts for username and password. Specify the username and password
that you have configured for global security.

Note:

How to Confirm Successful Un-setup
After executing the un-setup, if you receive the Un-setup Successful message, then the un-setup
of Interstage BPM server and console is completed successfully and you can now proceed to the
next step.
However, if you receive the Un-setup Failed: <error message> message, then it indicates that
un-setup is failed due to some reason. You can check the cause of any errors that occur during
un-setup by viewing the deployment.log file, located at the following location:
• On Windows: <engine directory>\server\deployment\logs

• On UNIX: <engine directory>/server/deployment/logs

Each time you execute the un-setup script, the contents of deployment.log file will be
overwritten. In some cases like specifying inappropriate options, the log file might not
generated.

Note:

If the un-setup also fails, you need to manually delete the resources. Refer to the section
Errors during Setup of the Interstage BPM Server on page 113

Note:

7.1.3 Backup Resources
Before you go to next step, you need to back up your resources. For detail information, refer Server
Administration Guide .

7.1.4 Remove engine Directory
You can remove the engine directory that you have copied during the setup of Interstage BPM.
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8 Upgrading Interstage BPM from Previous Versions
8.1 Outline

The basic steps for upgrading from previous version of Interstage BPM are described below:
To upgrade from previous versions of Interstage BPM:
1. Backup the complete Interstage BPM materials.
2. Uninstall the previous version of Interstage BPM.
3. Create a directory on your machine where you want to setup Interstage BPM and copy the engine

directory from Interstage BPM engine directory on product media to the directory created on your
machine

4. Upgrade your database according to the instructions in section Upgrade Database on page 58.
5. Upgrade the Interstage BPM Server and migrate application resources as described in Migrating

Application Resources from Previous Versions to this Version of Interstage BPM on page 65.

Following sections explain the instructions for each of these steps.

8.1.1 Back up the Interstage BPM materials
To upgrade from previous versions of Interstage BPM:
1. Before uninstalling the previous version of Interstage BPM:

• Back up the Interstage BPM database - This is the only way to ensure the retention of your
current Interstage BPM data. The upgrade process automatically migrates (and therefore
overwrites) process definitions to the current release's formats. Use the default functionalities
of your database software for backing up your database.

• Export out the Interstage BPM Server properties using the Interstage BPM export script. (For
details, refer Using the Configuration Export and Import Scripts on page 76.) This preserves
your previous server configurations. (If upgrading from Interstage BPM v7.x or v8.x, the
uninstallation program automatically saves your configuration files with the suffix previous
appended to their file names. For example, the ibpm.properties file is saved as
ibpmprevious.properties. ) After setting up the new version of Interstage BPM, you can
use the saved properties file to manually configure your new server setup. For information on
how to change the server configuration, refer to the Interstage Business Process Manager
Server Administration Guide.

• Back up all files from the previous agents/ folder
• Back up all files from the previous calendar/ folder
• Back up the resources/DataSourceDefinition.xml file
• Back up the resources/fileListenerConf.xml file
• Back up the DmsCollections.xml file and the directories specified in it - these directories

contain data that users have previously uploaded.

8.1.2 Upgrade Database
The database upgrade procedure consists of the following 3 main steps:
1. Schemamigration: This upgrade script does not require Java execution environment. This script

must be executed with admin credentials on the machine where database is installed. In case of
upgrading remote database, you need to copy the database upgrade script to remote database

Interstage BPM Server and Console Installation Guide (WebLogic Server) 58

8: Upgrading Interstage BPM from Previous Versions



machine and then configure the database parameters and execute the script, which will perform
the database migration.

2. Data migration: This step executes data conversion and initialization for new schema. This step
requires Java execution environment and can be executed from a remote machine that has
Interstage BPM setup. Hence you do not need to execute this step on the remote database
machine. This step fails if schema migration is not completed successfully.

If the Java execution environment is available on the database machine, you can execute
this step on the database machine also.

Note:

3. Post upgrade operations: This is the final step to complete the database upgrade. This script
does not require Java execution environments and must be executed on the database machine.
In case of upgrading remote database, you need to copy the database upgrade script to the
remote database machine and then configure the database parameters and execute the script,
which will perform the post upgrade operations. This step fails if data migration is not completed
successfully.
Before starting the execution of database upgrade script, you need to configure the parameters
in the configuration file. These parameters indicates which step to execute. You can either execute
all the scripts at one go or you can manually inspect and sequentially execute these three steps
of database upgrade procedure if your database resides on a machine other than the Interstage
BPM Server setup. For information regarding the configuration parameters, refer to the Parameters
for the database upgrade configuration file on page 59

Parameters for the database upgrade configuration file
Before you execute database upgrade script, you need to configure parameters in the database
upgrade configuration file config.bat / config.sh located at <engine
directory>/server/deployment/dbupgrade/bin directory.
You can edit config.bat / config.sh file using the text editor.

If special characters are included in the parameter value, you need to escape the character
followed by your shell.

Note:

Configuration Parameters for Database Upgrade:

DescriptionConfiguration Parameter

This parameter specifies whether the schema migration has to
be performed or not. The valid values are y or n.
• If set to y, this parameter enables the schema migration.
• If set to n, this parameter disables the schema migration.
Please refer to Upgrading Database on page 63 for the usage
example.

MIGRATE_SCHEMA

This parameter specifies whether the data migration has to be
performed or not. The valid values are y or n.
• If set to y, this parameter enables the data migration.
• If set to n, this parameter disables the data migration.
Please refer to Upgrading Database on page 63 for the usage
example.

MIGRATE_DATA
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DescriptionConfiguration Parameter

This parameter specifies whether the post upgrade operations
has to be performed or not. The valid values are y or n.
• If set to y, this parameter enables the post upgrade operations.
• If set to n, this parameter disables the post upgrade operations.
Please refer to Upgrading Database on page 63 for the usage
example.

POST_UPGRADE

This parameter specifies the edition you are upgrading from. The
valid values are y or n.
• If set to y, this parameter indicates that you are upgrading from

AE(Advanced Edition) to EE(Enterprise Edition)
• If set to n, this parameter indicates that you are upgrading from

EE to EE

AE_TO_EE

This parameter specifies the absolute path to the top-level directory
of your database installation.
Sample Value
• For Oracle:

• On Windows: C:\app\oracle\product\12.1.0\dbhome_1
• On UNIX:

/home/oracle/app/oracle/product/12.1.0/dbhome_1

• For Microsoft SQL Server: C:\Program Files\Microsoft
SQL Server

DB_HOME

This parameter specifies the absolute path to the directory where
your data files resides.
Sample Value
• For Oracle:

• On Windows: C:\app\oracle\oradata\orcl
• On UNIX: /home/oracle/app/oracle/oradata/orcl

• For Microsoft SQL Server: C:\Program Files\Microsoft
SQL Server\MSSQL11.MSSQLSERVER\MSSQL\DATA

DATAFILE_PATH
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DescriptionConfiguration Parameter

This parameter specifies the absolute path of the JDBC driver.
This parameter is mandatory to specify if you have set
MIGRATE_SCHEMA=y while upgrading from pre-10.1 version of
Interstage BPM or if you have set MIGRATE_DATA=y.
Sample Value
• For Oracle:

• On Windows:
C:\app\oracle\product\12.1.0\dbhome_1\jdbc\
lib\ojdbc7.jar

• On UNIX:
/home/oracle/app/oracle/product/12.1.0/dbhome_1/
jdbc/lib/ojdbc7.jar

• For Microsoft SQL Server:
On Windows: C:\MicrosoftSQLServer2012JDBCDriver\
sqljdbc_4.0\enu\sqljdbc41.jar

JDBC_DRIVER_PATH

This parameter specifies the absolute path to the top-level directory
of the JDK installation.
Sample Value: D:\java\jdk1.7.0_80
This parameter is mandatory to specify if you have set
MIGRATE_SCHEMA=y while upgrading from pre-10.1 version of
Interstage BPM or if you have set MIGRATE_DATA=y.

JAVA_HOME

This parameter specifies the type of database used. The valid
values are:
• oracle

• mssql

DB_TYPE

This parameter specifies the IP address or host name of the
machine where database is installed. If you do not specify the
value of this parameter localhost will be used.

DB_HOST

This parameter specifies the port on which your database is
running. It is used for creating database connection.
Sample Value:
• For Oracle: 1521
• For Microsoft SQL Server: 1433

DB_PORT

This parameter is specific to oracle database and indicates the
connection identifier used for creating database connection and
executing Oracle SQL scripts.

ORCL_SID

This parameter specifies the name of the database user.
Sample Value: ibpmuser

DBUSER
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DescriptionConfiguration Parameter

This parameter specifies the database user password.
Sample Value: ibpmuserpassword

DBPWD

This parameter specifies the name of database admin user.
Sample Value: ibpmadminuser

DBADMINUSER

This parameter specifies the database admin password.
Sample Value: ibpmadminuserpassword

DBADMINPWD

Copy the upgrade scripts
You need to copy the database upgrade scripts only if the Interstage BPM Server and the database
are setup on different machines. This is for remote database configuration. When the Interstage
BPM Server and database exist on the same machine, you do not need to copy the script.
1. Create a directory with a name (for example dbupgrade_local) on the machine where database

is installed.
2. From following directory, copy the directories in the dbupgrade_local directory that you have

just created:
• On Windows: <engine directory>\server\deployment\dbupgrade

• On UNIX: <engine directory>/server/deployment/dbupgrade

Directories to be copied to the database machine:
• If you are upgrading from pre-10.1 versions of Interstage BPM, copy the following folders:

1. bin

2. lib

3. For Oracle: oracle
4. For Microsoft SQL Server database: sqlserver

The lib directory includes Java code. Hence in this case, you need to make sure that the
Java execution environment is available on the database machine.

Note:

• If you are upgrading from V10.1 or above versions of Interstage BPM, copy the following
folders:
1. bin

2. For Oracle: oracle
3. For Microsoft SQL Server database: sqlserver

In this case, Java execution environment is not required on the database machine.Note:
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In UNIX, you must grant following permissions for the dbupgrade_local directory to the
user who executes the scripts.

Note:

• The dbupgrade_local directory and sub-directories: 'Read', 'Write' and 'Execute'
permissions.

• All files: 'Read' permission.
• All script (.sh) files: 'Execute' permission.

Upgrading Database
Pre-requisites: You have uninstalled the previous version of Interstage BPM.

In case of Oracle database in UNIX environment, make sure that you have set the following
environment variables as mentioned below:

Note:

• ORACLE_HOME=<Database Installation directory>

For example:
ORACLE_HOME=/home/oracle/app/oracle/product/12.1.0/dbhome_1; export
ORACLE_HOME

• ORACLE_SID=<Database identifier>

For example:
ORACLE_SID=orcl; export ORACLE_SID

If you want to execute the database upgrade script in the Java execution environment and
the Interstage BPM Server and database are exist on the same machine, follow these steps:
1. Configure the parameters in the config.bat / config.sh file located at:

• On Windows: dbupgrade\bin
• On UNIX: dbupgrade/bin
Configure the parameters as below:

MIGRATE_SCHEMA=y
MIGRATE_DATA=y
POST_UPGRADE=y

For more information, refer to the Parameters for the database upgrade configuration file on
page 59

2. Run the upgrade script dbupgrade.bat / dbupgrade.sh as shown below. The script file located
at the:
• On Windows: dbupgrade\bin
• On UNIX: dbupgrade/bin
If you want to overwrite values of any of the database configuration parameters that you have
specified in the configuration file config.bat / config.sh, at runtime you can provide the
parameters and its value from the command line while executing the upgrade script.

Use the following command to execute this script:

dbupgrde.bat dbuser=<dbuser> dbpwd=<db password> dbadminuser=<db
administrator> dbadminpwd=<db administrator password> JDBC_DRIVER_PATH
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="C:\Microsoft SQL Server\sqljdbc_2.0\enu\sqljdbc41.jar"
JAVA_HOME=C:\Java\jdk7

Note: • If any space used in parameter values then values must be enclosed in double quotes.
For example: DATAFILE_PATH="C:\Program Files\Microsoft SQL
Server\MSSQL11.MSSQLSERVER\MSSQL\DATA"

• On the command line, you can specify only the parameters supported in the configuration
file. If you specify any unsupported parameters, it may cause an error. Refer to the
Configuration Parameters table described above.

• If you have set the password parameters in the configuration file, secure the file for
security reasons.

If the Java execution environment is not available on database machine. In this case, the Interstage
BPM Server usually exists on different machine then you need to execute the scripts for each step
of database upgrade, as described below:
1. Migrating Database Schema: This procedure must be executed on the machine where database

is installed.
a) Copy the directories on the database machine according to the instructions in the Copy the

upgrade scripts on page 62
b) Configure the following parameters in the config.bat / config.sh file located in the

dbupgrade_local\bin folder that you have copied in previous step.
For more information, refer to the Parameters for the database upgrade configuration file on
page 59.

MIGRATE_SCHEMA=y
MIGRATE_DATA=n
POST_UPGRADE=n

c) Run the upgrade script dbupgrade.bat / dbupgrade.sh file located in the
dbupgrade_local\bin folder that you have copied, as described above.

2. Migrating Data: This procedure can be executed from a non-database (remote) machine.

This procedure can be executed only if the database schema migration is completed
successfully.

Note:

a) Configure the migration parameters in the config.bat / config.sh file located at <engine
directory>\server\deployment\dbupgrade\bin as shown below.
For more information, refer to the Parameters for the database upgrade configuration file on
page 59.

MIGRATE_SCHEMA=n
MIGRATE_DATA=y
POST_UPGRADE=n

b) Run the upgrade script dbupgrade.bat / dbupgrade.sh located at <engine
directory>\server\deployment\dbupgrade\bin folder, as described above.

3. Executing Post Migration operations
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This procedure can be executed only if the data migration is completed successfully.Note:

a) On the machine where database is installed, navigate to the dbupgrade_local\bin directory
and configure the migration parameters in the config.bat / config.sh file as shown below.
For more information, refer to the Parameters for the database upgrade configuration file on
page 59.

MIGRATE_SCHEMA=n
MIGRATE_DATA=n
POST_UPGRADE=y

b) Run the upgrade script dbupgrade.bat / dbupgrade.sh located in the dbupgrade_local\bin
directory, as described above.

8.1.3 Upgrade Interstage BPM and Migrate Application Resources
To upgrade Interstage BPM and migrate application resources:
1. Setup the Interstage BPM Server and/or Console according to the instructions in section Setting-up

Interstage BPM Server and Console on page 21.

Specify 1 to database_creation_selection in setup.config. Otherwise, the old database
will be overwritten and you will lose all of the previous work that is stored in the database.

Note:

Once upgrade is completed, the ApplicationSecurityMode server configuration parameter
is set to Secure (SaaS mode) by default as the setup is always in SaaS mode. Therefore
if you want to keep using Interstage BPM with non-SaaS mode, you should change the
property value from Secure to Relax. How to change server parameters is described in the
Interstage BPM Server Administration Guide.

Note:

2. Migrate application resources as described in Migrating Application Resources from Previous
Versions to this Version of Interstage BPM on page 65.

3. Start the Interstage BPM Server and Console. Refer the following sections:
• Starting Interstage BPM Server on page 32
• Starting Interstage BPM Console and Tenant Management Console on page 33

4. If needed, migrate the application owners as described in Migrating Application Owners from
Previous Versions to this Version of Interstage BPM on page 67

Interstage BPM is now upgraded to the latest version.

8.2 Migrating Application Resources from Previous Versions
to this Version of Interstage BPM
Pre-requisites: You have completed the previous steps as described in Outline on page 58.
• If you are upgrading from a version of Interstage BPM that do not support SaaS mode or if you

were using Interstage BPM with non SaaS mode, you have to setup an instance of Interstage
BPM Server, and after setup, you have to change the ApplicationSecurityMode server
configuration parameter to relax.
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To migrate application resources from previous versions to this version of Interstage BPM:
1. Copy the DmsCollections.xml file of the previous version to the <engine

directory>/server/instance/default/tenants/Default/resources/ folder. (Replace the
DmsCollections.xml present at this location.)
Essentially, to be able to use attachments from the previous Interstage BPM version, you need
to continue to use the same DMSRoot you used in the previous version.

2. Copy the apps folder from <engine
directory>/server/instance/default/tenants/Default/attachments/ to the DMSRoot
<Path> specified in DmsCollections.xml.

For UNIX environments, while specifying the DMSRoot, ensure you use the correct case
in the file path.

Note:

3. Create a new directory named engine_classes in the <DMSRoot>/apps/<app_ID>/ and copy
all the class files for generic Java Actions in this engine_classes directory.

4. For each application, do one of the following:
a) If an application already contains the agentsConfig.xml file (located in

<DMSRoot>/apps/<application id>/), add the following code to that file:

<ActionAgent>
<Name>@FTP</Name>
<Description>FTP Agent</Description>
<RetryInterval>20</RetryInterval>
<EscalationInterval>1</EscalationInterval>
<ClassName>com.fujitsu.iflow.serveree.impl.actionagent.ServiceAgent

</ClassName>
<ConfigFile>ftp.xml</ConfigFile>

</ActionAgent>
<ActionAgent>

<Name>@HTTPAgent</Name>
<Description>HTTP Agent</Description>
<RetryInterval>20</RetryInterval>
<EscalationInterval>1</EscalationInterval>
<ClassName>com.fujitsu.iflow.serveree.impl.actionagent.httpservice.

HTTPServiceAgent</ClassName>
<ConfigFile>HTTPAgent.xml</ConfigFile>

</ActionAgent>

b) If an application does not contain the agentsConfig.xml file (located in
<DMSRoot>/apps/<application id>/)
• Copy the agentsConfig.xml file of the previous version to the <DMSRoot>/apps/System

folder.
• Edit the copied agentsConfig.xml to remove 'agents/' from the text within the

<ConfigFile> tag.

5. Copy the fileListenerConf.xml file of the previous version to the <DMSRoot>/apps/System
directory.

6. Copy the previous versions of each of the following to each application folder in the
<DMSRoot>/apps/<application id>/ directory.
• HTTPAgent.xml file
• ftp.xml file
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• Business Calendar (.cal) files
• DataSourceDefinition.xml file

Do not migrate Decision Table Management (DTM) configuration files from previous versions
of Interstage BPM; this version of Interstage BPM does not support DTM configuration files
of pre-v11.0 versions.

Note:

7. Synchronize the Interstage BPM Console with your DMSRoot using the following steps:
a) Login to Interstage BPM Console as an administrator.
b) After choosing an application, in the SystemAdministration tab, clickApplication Settings.
c) In the Application Settings page, click Synchronize with DMS, and then click Synchronize

in the pop-up that appears.
Note: Repeat the above steps for all the tenants.

From this version of Interstage BPM:Note:
• Parent process definitions can only call sub process definitions if they exist in the same

application. To continue using parent process definition from previous versions in
Interstage BPM V11.0, ensure their sub process definitions exist in the same application
as the parent process definition.

• You cannot migrate process instances from one application to another.
• You cannot copy process definitions from one application to another.

8.3 Migrating Application Owners from Previous Versions to
this Version of Interstage BPM
When you migrate applications prior to this version to this version of Interstage BPM, the user group
having the role of AdminRole is automatically set as the owner of the application. After application
migration, if you want to assign application ownership to a group other than the AdminRole, you can
do so by using Interstage BPM Console. For information about changing application owners in
Interstage BPM Console, refer the Managing Applications section of the Interstage BPM Console
Online Help.

8.4 Migrating WebDAV Repository and UDDI Registry from
Previous Versions to this Version of Interstage BPM
If you had configured Interstage BPM of the version prior to this version to use WebDAV repository
and UDDI registry (such as Centrasite), you need to configure for WebDAV and UDDI repositories.
This configuration is possible by using Interstage BPM Tenant Management Console or the
ImportProperties command.
After this configuration is complete, you need to synchronize the Interstage BPM Server with your
WebDAV and UDDI repositories before you can use already published information or publish new
process definitions. Use the following steps to achieve this:
1. After upgrade and configuration of Interstage BPM Server and Console, start the Interstage BPM

Server and Console.
• Starting Interstage BPM Server on page 32
• Starting Interstage BPM Console and Tenant Management Console on page 33
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2. Login to Interstage BPM Console as an administrator.
3. After choosing an application, in the System Administration tab, click Application Settings.
4. In the Application Settings page, click Synchronize with Repository, and then click

Synchronize in the pop-up that appears.
Once synchronization is successful, an appropriate message is displayed.

Now this version of Interstage BPM is ready to be used with WebDAV and UDDI repositories

8.5 Additional Steps for Handling Pre-11.0 Console URLs
From version 11.0 of Interstage BPM Console, the Interstage BPM Console URL has been changed,
making older versions of URLs such as those of Remote Sub-Processes, Service Registry, and so
on incompatible when called from previous versions of Interstage BPM.
To overcome this problem, deploy the Compatibility Proxy WAR provided in this release using the
steps listed in this section.

Note: 1. For a remote subprocess, perform the steps listed here only in the following cases:
• When both the Parent and child process instances are running, and you upgrade

Interstage BPM on the parent server to v11.0
• When the parent process is running but the child process instance has not yet started,

and you upgrade Interstage BPM on the child server to v11.0

2. Support for HTTPS is not available in this release.

In order to use the Compatibility Proxy for supporting pre-V11.0 URLs, the following requirements
must be met:
• You should setup an instance of Interstage BPM Server, and after setup, you should change the

ApplicationSecurityMode server configuration parameter to relax.
• The Compatibility Proxy should be deployed at the original pre-V11 context root, and the V11

Console should be deployed at a different context root. For example, if the pre-v11.0 Console
was deployed at the context root ibpmconsole, then you should install the compatibility proxy at
ibpmconsole and the V11 Console at any other context root, for example, console. The default
context root for V11 Console is console, which is different from the default context root for any
previous version. So if you have followed the defaults, this requirement rule will be automatically
satisfied.

• V10.x had the restriction that two applications cannot have process definitions with the same
name. This restriction has been removed in V11.0. But to use the Compatibility Proxy, the same
restriction needs to be followed, that is, two applications should not have process definitions with
the same name.

8.5.1 Steps to Overcome the URL-incompatibility Problem
Pre-requisites: You have completed the previous steps as described in Outline on page 58:
• You have setup an instance of Interstage BPM Server and Console, and after setup, you have

changed the ApplicationSecurityMode server configuration parameter to relax.
• Make sure that the WebLogic Server is running.

Interstage BPM Server and Console Installation Guide (WebLogic Server) 68

8: Upgrading Interstage BPM from Previous Versions



To overcome the URL-incompatibility problem caused by pre-11.0 URLs:
1. Create a folder whose name corresponds to your pre-v11.0 context root (for example ibpmconsole)

on your machine. For example purposes, the following directory will be used:
On UNIX or Linux:
/opt/FJSVibpm/ibpmconsole

On Windows:
c:\fujitsu\InterstageBPM\ibpmconsole

2. Copy webserviceproxy.war from the console directory of your product media to the directory
that you just created on your machine.

3. Extract the files from webserviceproxy.war into the ibpmconsole directory. Use the following
Java command:
jar -xvf webserviceproxy.war

4. After extracting the jar, edit the proxy.conf file under <Extraction Directory>\WEB-INF\config
and update the ServerBaseURL to the V11 port number and context root.

5. Start the WebLogic Server Default Server. For details, refer Starting WebLogic Administration
Server on page 19.
The WebLogic Administration Server will start in a Console Window.

6. Start the Interstage BPM Server to which you want to connect in WebLogic. For details, refer
Starting Interstage BPM Server on page 32.

7. Open the WebLogic Admin Console by entering the following URL in your Web Browser:
http://<hostname>:7001/console

The WebLogic Administration Console will open in your Web Browser.

8. Login to the WebLogic Administration Console.
9. Deploy the webserviceproxy.war on the WebLogic Application Server. See the Deploy Web

Application topic in the WebLogic Server Administration Console Help for instructions specific to
the particular version of WebLogic that you are using.

10. Deploying the webserviceproxy using the WebLogic Administration Console:

Two different scenarios are presented in these instructions. In Case 1, the webserviceproxy
is deployed in the same WebLogic Server Domain as the Interstage BPM Server. In Case
2, the webserviceproxy is deployed in a WebLogic Server Domain other than the one used
by the Interstage BPM Server.

Note:

a) In the left pane of the Administration Console, click Lock & Edit, so you can deploy the
webserviceproxy.war. This action greys out the Lock & Edit button and makes the Release
Configuration button available. The WebLogic Administration Console is now in edit mode.
The WebLogic configuration cannot be changed unless you are in edit mode.

In WebLogic, this step is not required if the Automatically acquire lock and activate
changes option is enabled in your admin console Preferences.

Note:

b) In the left pane of the Administration Console, click Deployments in the Domain Structure
list. The Summary of Deployments page appears.

c) In the right pane, click Install. The Install Application Assistant page appears.
d) Click the link for Location and navigate to the ibpmconsole (where we have extracted the

webserviceproxy.war in Step 3) directory.
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e) Check the ibpmconsole checkbox. Then, click Next. The Choose Targeting Style step of the
Install Application Assistant is displayed.

f) Make sure that the Install this deployment as an application checkbox is checked. Then,
click Next.

g) For Case 1, check the InterstageBPMServer checkbox in the Servers list. For Case 2, you
only have the option of using the Admin Server, so no action is needed on this screen.

h) For Case 1, click Next. For Case 2, click Finish. In Case 1, the Optional Settings step of the
Install Application Assistant is displayed. In Case 2, you can skip the next step.

i) You do not need to make any optional settings, so click Next.
j) Activate your deployment by clicking Activate Changes. A message appears informing you

that your changes have been activated.

In WebLogic, this step is not required if the Automatically acquire lock and activate
changes option is enabled in your admin console Preferences.

Note:

k) Click Deployments in the Domain Structure list. Your newly deployed Web Application
appears in the Deployments list.

l) For Case 1, make sure that your Interstage BPM Server is running because you will not be
able to start ibpmconsole (webserviceproxy) if it is not running.

m) Check the Selection box of ibpmconsole (webserviceproxy), then select Servicing all
requests from the Start drop-down list to the Web application.

n) Click Yes to confirm that you want to start the selected Web applications. A page indicating
that the deployment has started will appear.

11. Start the Interstage BPM Server and Console. Refer the following topics:
• Starting Interstage BPM Server on page 32
• Starting Interstage BPM Console and Tenant Management Console on page 33

8.6 Additional Steps for Form Styles while Migrating from
Interstage BPM Console 11.1
Versions of Interstage BPM Console later than v11.1 allow changing the look and feel of Interstage
BPM Console forms using Interstage BPM Console itself. If you are migrating from Interstage BPM
Console 11.1, and you were using custom stylesheets for either:
• tenants (stylesheet placed under //<console

WAR>/tenant/<tenantName>/web/styles/custom.css or //<console
WAR>/web/styles/custom.css), OR

• applications (stylesheet placed under //<console
WAR>/tenant/<tenantName>/apps/<appName>/web/styles/customTheme.css)

after migration, ensure you define form-specific style classes in the custom CSS files.
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8.7 Additional Steps for Interstage BPM Console

8.7.1 Deleting Interstage BPM Console
In version 11.2.1 of Interstage BPM, Interstage BPM Console is always setup with Interstage BPM
Server. Therefore if you do not want to work with Interstage BPM Console you can un-setup it from
your application server.
On WebLogic:
1. Access the Administration Console of WebLogic Server, and in the Domain Structure tree, select

Deployments.
2. In Summary of Deployments, in the Control tab, select the InterstageBPMConsole checkbox.
3. Click Delete.

8.7.2 Updating System Properties for Web Server Port
If you changed your WebServer port from default value, you need to change the following System
properties.
• ServerBaseURL
• ServerEmailBaseURL
You can update these values via the Interstage BPM Tenant Management Console or Import/Export
property commands. How to change properties using Tenant Management Console is explained in
the Interstage BPM Tenant Management Console Online Help. Details of using import/export
commands are described in the Interstage BPM Server Administration Guide.
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Appendix A: Security
Interstage BPM can be set to two security levels: Demo Mode and Security Mode. Demo Mode is
useful while key members of your work team learn the features of the software. Later, Security Mode
provides a stable and controlled environment for implementing Interstage BPM across your company.

A.1 Interstage BPM Operation Model
It is assumed that Interstage BPM is used in an organizational Intranet. VPN is used when connecting
from Internet to Intranet. In most situations, end-users will work with Interstage BPM applications via
a firewall, administrators, however, will be using the server segment.
End-users do not need to run applets or other clients requiring the Interstage BPM model. This means
that the only port that needs to be opened in the firewall is the standard HTTPS port (443) and the
Web Server in the server segment.
The following diagram depicts a setup situation where Interstage BPM applications are used via a
firewall. It also shows possible security threats – these are described in more detail in the subsequent
table.

Figure 17: Interstage BPM Operation Model

The following table lists the possible security threats as well as possible solutions:
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SolutionThreat#

Use SSL.Message interception(1)

Make sure that your administrators are properly trained and
certified, and that the firewall, the Web Server, the Interstage
BPM Server, the Database Server and the Directory Server are
configured correctly.

Wrong configuration(2)

Use firewall configuration to block illegitimate requests.Denial of service(3)

Use secure cookies if you are using cookies for session
management.

Cookie wiretap(4)

Keep the Web Server, Interstage BPM Server, the Directory
Server and the Database Server machines in a secure location.

Internal message
interception

(5)

Keep the Web Server, Interstage BPM Server, Directory Server
and Database Server machines in a secure location. Set the
operating system/database permissions such that file/database
access is possible only by authorized people.

Alternation of config file or
database

(6)

All guessed passwords should be changed to something that
is less vulnerable. Passwords should not be proper nouns (e.g.,
a person's name), a word found in a dictionary or the same
string as the user name.
Ideally, a password should contain a minimum of 6 characters
in a mixture of upper case, lower case, numeric digits and other
characters. In addition, it should not contain more than two
identical consecutive characters and more than two ascending
or descending consecutive characters.

Password susceptible to
brute force attack

(7)

Install under the condition that no one is around you.Password peep during the
installation

(8)

Secure the configuration files after setup.Remaining passwords could
be leaked

(9)

As a rule, always use anti-virus software.Virus or worm injection(10)

A.2 Password Encryption
The Interstage BPM setup script encrypts the passwords entered during setup and writes the encrypted
passwords into the database.
The Interstage BPM Server decrypts all passwords at startup. If decryption fails, a warning message
is printed in the Trace.log file.
If you need to change the user/passwords after completion of setup, an Encryption Utility is provided
so that you can encrypt the passwords and overwrite them in the server's configuration. The Encryption
Utility does not provide for decryption of passwords. It can only be used for encryption.
Initially, a default key is used to encrypt and decrypt the passwords. If you want to use a different
key for security reasons, you must add this key to the server's configuration. The default key is not
published; it is hardcoded in the server code.
The Encryption Utility provided is:
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com.fujitsu.iflow.utilities.TextEncrypter.class

To call the Encryption Utility, use the encryption script located in <engine
directory>/client/samples/configuration:
• On Windows: EncryptPassword.bat
• On UNIX: EncryptPassword.sh

Encrypting a Password With the Default Key
To encrypt a password with the default key, run the script with the following option:
On Windows: EncryptPassword.bat -e "<TextPassword>"

On UNIX: EncryptPassword.sh -e "<TextPassword>"

Make sure to enclose the password and the encryption key in double quotes. Otherwise,
the encryption process might fail. As double quotes are delimiters, do not use double quotes
in the encryption key.

Note:

Encrypting Passwords With a New Key
You are recommended to encrypt your passwords with your own key.
To encrypt a single password with a new key, run the script with the following options:
On Windows: EncryptPassword.bat -e "<TextPassword>" "<Key>"

On UNIX: EncryptPassword.sh -e "<TextPassword>" "<Key>"

If a key other than the default key is used, it should contain more than 23 characters.
Make sure to enclose the password and the encryption key in double quotes. Otherwise,
the encryption process might fail. As double quotes are delimiters, do not use double quotes
in the encryption key.

Note:

During startup of the Interstage BPM Server, the key needs to be present in the server's configuration.
Therefore, before starting the server, use the configuration export and import scripts to add the
following parameter to the server's configuration:
EncryptionKey=<Key>

For details on the procedure, refer to section Using the Configuration Export and Import Scripts on
page 76. For security reasons, the key can be removed again from the system or tenant configuration
file that you imported into the database.
Alternatively, you can encrypt all passwords in a system or tenant configuration file at the same time
before importing it into the database. To do this, substitute all passwords in the configuration file with
actual text passwords and encrypt the configuration file by running the script with the following options:
On Windows: EncryptPassword.bat -f "<Path of Configuration File>" "<Key>"

On UNIX: EncryptPassword.sh -f "<Path of Configuration File>" "<Key>"

Make sure to enclose the file path and the encryption key in double quotes. Otherwise, the
encryption process might fail. As double quotes are delimiters, do not use double quotes
in the encryption key.

Note:

The following parameters in the configuration file are encrypted using this method:
• LDAPAccessUserPassword

• MetadataRepositoryPassword
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• ServerPassword

• SMTPPassword

• SWAPLinkagePassword

• UDDIPublisherPassword

Example
Use the following command to encrypt all passwords in the system or tenant configuration file at the
same time.
On Windows: EncryptPassword.bat -f
"C:\SomeDirectory\MyServerConfiguration.properties" "EWAERJQ23FIQ0J22"

On UNIX: EncryptPassword.sh -f "/SomeDirectory/MyServerConfiguration.properties"
"EWAERJQ23FIQ0J22"

If including all leading and trailing white space characters in a password, use -t option
instead of -f option not to trim the leading and trailing white space characters.

Note:

A.3 Using Demo Mode and Security Mode
Interstage BPM can be set to two security levels: Demo Mode and Security Mode. Demo Mode is
useful while key members of your work team learn the features of the software. Later, Security Mode
provides a stable and controlled environment for implementing Interstage BPM across your company.
Demo Mode restricts access to Interstage BPM in two ways:
• Only the person who is assigned a work item may make choices about it, thus advancing the

process to the next work item - or completing it.
• Only members of the AdminRole can access administration functions in the Interstage BPM

Console.
All Interstage BPM users can experiment with all of Interstage BPM functions, including creating and
editing process definitions and process instances.
In Security Mode, access to process definitions, process instances, and work items are restricted
to the specific people who need to use them. The following are examples of people who need to use
them:
• Only members of the Role specified in the TemplatePublishers parameter of the Interstage

BPM Server can create new process definitions.
• Only the process instance owners, current assignees, and Interstage BPM Administrators can

view any specific process instances. (Current assignees are those who have active task
assignments. This does not include people who will have task assignments later in the process.)

• Only the process instance owners, current assignees, and Interstage BPM Administrative Users
can edit their specific process instances. This means they can change User Defined Attributes
and add or delete attachments. However, they are not allowed to edit the process structure.

To set up Security Mode:
• Add the following parameters to the server configuration:

SecuritySwitch=true

This setting enables Security Mode.
TemplatePublishers =<Registered Role>
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This Role must be registered in Interstage BPM's local group store or in your Directory Service.
For example, if you have defined a Role of pubRole, you would type
TemplatePublishers=pubRole. Be aware that this key takes effect only if the Security Mode is
switched on.
For information on how to add parameters, refer to section Using the Configuration Export and
Import Scripts on page 76.

A.4 Configuring SMTP Authentication for Use with Interstage
BPM

Only a System Administrator should perform these instructions.Note:

If you required SMTP Authentication for logging in to Interstage BPM, use the following instructions:
1. Set up an email server and enable SMTP Authentication.
2. Add the following parameters to the server configuration:

SMTPServerHost=<Email Server Host Name>

SMTPUserName=<User Name for SMTP Authentication>

SMTPPassword=<Password for SMTP authentication>

For details on the procedure, refer to section Using the Configuration Export and Import Scripts
on page 76.

3. Design a process definition to test the email feature.
Refer to the Interstage Business Process Manager Studio User's Guide for information on how
to design process definitions.

If the SMTPUserName or SMTPPassword are set correctly, the email will be accepted by the email
server. If neither the SMTPUserName nor SMTPPassword values are blank, Interstage BPM will use
the SMTP authentication feature.

A.5 Using the Configuration Export and Import Scripts
Prerequisite: The database server is running.

Interstage BPM comes with configuration export and import scripts that allow you to change the
server configuration. You can use these scripts to add parameters that are not present in the
configuration or remove parameters from the configuration. If the server fails to start or denies login
due to configuration errors, you can use the scripts to import a working configuration into the database.
You can add or edit both System as well as Tenant properties using the export and import scripts.
For more information about System and Tenant properties, refer the Interstage BPM Server
Administration Guide.
The Interstage BPM Server is not required to be running for the configuration export and import
scripts to be used.
To use the configuration export and import scripts:
1. Export the server configuration by running the export script located in <engine

directory>/server/deployment/bin:
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Configuration Export ScriptOperating System

• For System Properties:
exportProperties.bat <File Name> <Database User Name>
<Password>

Example:
exportProperties.bat MyServerConfiguration.properties
SomeUserName SomePassword

• For Tenant Properties:
exportProperties.bat <File Name> <Database User Name>
<Password> <TenantName>

Note that <TenantName> is case-sensitive.
Example:
exportProperties.bat MyServerConfiguration.properties
SomeUserName SomePassword Default

Windows

• For System Properties:
exportProperties.sh <File Name> <Database User Name>
<Password>

Example:
exportProperties.sh MyServerConfiguration.properties
SomeUserName SomePassword

• For Tenant Properties:
exportProperties.sh <File Name> <Database User Name>
<Password> <TenantName>

Note that <TenantName> is case-sensitive.
Example:
exportProperties.sh MyServerConfiguration.properties
SomeUserName SomePassword Default

UNIX

For <File Name>, specify the file name and, optionally, the path of the configuration file to be
generated. If you do not specify a path, the configuration file is written to the current directory.
For <Database User Name> and <Password>, specify the database user account that you defined
during setup of the Interstage BPM Server.

Before you make any changes to the configuration file, create a copy of the configuration
file you exported as a back-up. In case you make errors while editing parameters and import
the file, Interstage BPM Server may not be able to start or errors may occur at runtime. In
such a case you can use the back-up file which contains a working configuration.

Note:

2. Make the required changes in the generated configuration file.
If you want to add parameters, use the following syntax:
<Parameter Name>=<Parameter Value>
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Note: • Parameter names and values are case sensitive.
• Any backslashes "\" or colons ":" used in parameter values must be escaped by

backslashes. For example, a server address is specified like this:
ibpmhost\:49950

• Some configuration parameters have a <Hostname> or <Hostname>.<Servername> suffix
appended to their names. These suffixes are automatically removed during the export
and are automatically appended during the import. Do not add these suffixes to the
parameter names.

Passwords in the generated configuration file are encrypted for security reasons. If you change
a password, you are recommended to encrypt it before importing the configuration file. Passwords
are not automatically encrypted during the import. For details on how to encrypt passwords, refer
to section Password Encryption on page 73.

3. Import the updated configuration file into the database by running the import script located in
<engine directory>/server/deployment/bin:
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Configuration Import ScriptOperating System

• For System Properties:
importProperties.bat <File Name> <Database User Name>
<Password>

Example:
importProperties.bat MyServerConfiguration.properties
SomeUserName SomePassword

• For Tenant Properties:
importProperties.bat <File Name> <Database User Name>
<Password> <TenantName>

Note that <TenantName> is case-sensitive.
Example:
importProperties.bat MyServerConfiguration.properties
SomeUserName SomePassword Default

Windows

• For System Properties:
importProperties.sh <File Name> <Database User Name>
<Password>

Example:
importProperties.sh MyServerConfiguration.properties
SomeUserName SomePassword

• For Tenant Properties:
importProperties.sh <File Name> <Database User Name>
<Password> <TenantName>

Note that <TenantName> is case-sensitive.
Example:
importProperties.sh MyServerConfiguration.properties
SomeUserName SomePassword Default

UNIX

For <File Name>, specify the file name and, if required, the path of the updated configuration
file. You need to specify the path if the configuration file is not located in the current directory.
For <Database User Name> and <Password>, specify the database user account that you defined
during setup of the Interstage BPM Server.

4. In a cluster setup, each server node must be configured individually. Therefore, repeat steps 1-3
for the other server nodes.

5. Restart the Interstage BPM Server for the changes to take effect.
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Appendix B: Running Interstage Business Process
Manager in Solaris Containers

The Solaris "container" feature enables you to run several Solaris servers with the same version of
the Solaris operating system on the same physical machine. Each of the Solaris servers configured
in this way is called a "container" with the following properties:
• individual, separate IP address
• individual server name
• individual file system
• individual or shared resource pool
For instructions on setting up Solaris containers, refer to the Solaris product documentation. Below,
you find a sample setup.

Sample
This section lists all commands that need to be called on a Solaris machine in order to set up a
container with the following settings:
• Container name (host name): IBPM_Test
• IP address: 11.1.111.111
• File system: default
• Additional devices: none
• Project: myIBPMProject
• Resource pool: minimum 2 and maximum 4 CPUs
The basic Solaris installation consists of exactly one container (or zone): the global zone. Every
additionally installed zone is called local zone or container. Proceed as follows:
Step 1: Configuring the container
1. Create a root directory for the IBPM_Test container:

mkdir -p /export/zones/IBPM_Test

2. Set the user permissions:

chmod 700 /export/zones/IBPM_Test

3. Create and configure the container:

zonecfg -z IBPM_Test
create
set zonepath=/export/zones/IBPM_Test
set autoboot=true
add net

set address=11.1.111.111
set physical=hme0

end
verify
commit
exit
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4. Install the container:

zoneadm -z IBPM_Test install

5. Boot the container:

zoneadm -z IBPM_Test boot

6. Login to the container:

zlogin -C IBPM_Test

7. Proceed with answering the default questions for the container settings when you log in for the
first time.

Step 2: Setting up ssh connectivity for the container
1. Edit the /etc/ssh/sshd_config file:

vi /etc/ssh/sshd_config

and set the PermitRootLogin to yes.

2. Restart the container:

init 1
init 3

After having finished the initial setup, leave the current prompt by typing ~. (currently you are logged
in as the root of the global container). All subsequent actions can be performed if you log in as root
user via ssh.
Step 3: Setting up a resource pool and binding it to the container
1. Create a processor set:

poolcfg -c 'create pset ibpm (uint pset.min=2; uint pset.max=4)'

2. Create the resource pool:

poolcfg -c 'create pset ibpmpool (string pool.scheduler="FSS")'

3. Associate the processor set to the pool:

poolcfg -c 'associate pool ibpmpool (pset ibpm)'

4. Enable the settings:

pooladm -c

5. Verify the settings:

poolcfg -dc info
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Step 4: Binding the pool to the container
1. Set the pool for the container:

zonecfg -z IBPM_Test set pool=ibpmpool

2. Bind the pool to the container:

poolbind -p ibpmpool -i zoneid IBPM_Test

3. Exit the prompt.
Step 5: Setting up the project for the container
1. Log on to the local container IBPM_Test as user root.
2. Create a project myIBPMProject for user root:

projadd -c "IBPM default project" -U root myIBPMProject

3. Set the maximum shared memory for the project:

projmod -sK "project.max-shm-memory=(priviliged,521M,deny)" myIBPMProject

4. Set the CPU shares for the project:

projmod -sK "project.cpu-shares=(privileged,100,none)" myIBPMProject

Step 7: Starting Interstage Business Project Manager
1. To start Interstage Business Process Manager and apply the restrictions set in the previous steps:

newtask -p myIBPMProject

All activities that will be started subsequent to the above command will be subject to the set resource
restrictions and be started for / in the myIBPMProject of the IBPM_Test container.
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Appendix C: Clustering, Load Balancing, and Failover
This appendix provides you with an effective means of increasing the scalability and reliability of
your Interstage Business Process Manager system. Configuring your system for load balancing can
increase scalability. Configuring your system for failover can increase reliability.
This appendix provides guidelines for setting up a cluster of Interstage BPM Servers. It also provides
guidelines for configuring that cluster for load balancing and failover.
In an Interstage BPM Cluster, multiple Interstage BPM Servers are setup to work in concert with
each other. In other words, they work together as a unit. The default Interstage BPM Cluster is
configured for load balancing in a round-robin configuration and for failover. For Interstage BPM
Clusters in a round-robin configuration, requests sent to the cluster are distributed evenly among
the servers in the cluster. If the cluster is configured for failover, a working server in the cluster
automatically "takes over for" a server in the cluster that has just failed for some reason.

Ensure that all machines that you plan to include in a cluster are in the same Time Zone,
and the difference between their system times is not more than 5 minutes.

Note:

C.1 Setting Up an Interstage BPM Cluster on WebLogic
Application Server
To set up an Interstage BPM Cluster, you must first configure a cluster of Interstage BPM Servers,
and then connect that cluster to all of the Interstage BPM components in the same manner that they
were connected to a single Interstage BPM Server. Setting up the cluster consists of the following
major steps:
1. Preparing the cluster setup. This involves preparing the database, the application server and

Interstage BPM Server.
2. Configuring environment variables
3. Configuring Interstage BPM for the cluster by running a script
4. Configuring the Shared Resource Root
5. Updating the Interstage BPM Server configuration files
6. Deploying the Interstage BPM Console
7. Deploying the OpenID Provider
8. Updating the Interstage BPM Client configuration
9. Updating environment variables and server startup scripts
10. Importing the Interstage BPM Server configuration files
11. Starting the cluster
12. Implementing failover if you require this feature
The sample cluster used to illustrate the instructions in this section is setup on two computers. The
computer with hostname svmd2 is the computer on which the WebLogic Administration Server is
running. svmdapp5 is the other computer in the sample cluster. The cluster is configured to run a
standard load-balancing algorithm known as round-robin. A file server is used for storing documents
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that need to be accessed by all cluster nodes, for example attachments to process instances. The
following figure shows the sample system.

Figure 18: Sample Cluster

The next sections provide step-by-step instructions on how to set up the cluster.

For setting up vertical cluster, refer to the Running Two Cluster Servers on the Same
Computer (Optional) on page 101.

Note:

C.1.1 Preparing the Cluster
Prerequisites:
Check the default settings for the multicast group. A multicast group is used to distribute information
among the Interstage BPM Servers in a cluster. These are the default settings used by the Interstage
BPM Servers:
• Multicast port number: 5000
• Multicast group address: 225.4.5.6

A multicast group address is an IP address in the range 224.0.0.0 to 239.255.255.255, inclusive.
It is used to identify the members of a multicast group. Each member of the group uses the same
multicast group address. The address 224.0.0.0 is reserved and must not be used.

1. Create a directory on your machines that you want to include as nodes in your cluster setup and
copy the engine directory from Interstage BPM product media to the directory created on your
machines.

2. On each node, check and if require update the value for JAVA_HOME parameter in the setIBPMJava
script located at <engine directory>/server/deployment/bin/.

3. Run the startMulticastReceiver script on each server node as follows.

<startMulticastReceiver script> <address> <port>
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For example:
On Windows:

startMulticastReceiver.bat 225.4.5.6 5000

On UNIX:

startMulticastReceiver.sh 225.4.5.6 5000

4. Run the startMulticastSender script on one of the server nodes and check whether all server
nodes are receiving the multicasts. Use the following format:

<startMulticastSender script> <address> <port>

With the startMulticastSender script, use the same address-port pair as used with the
startMulticastReceiver script in step 3.

Note:

For example:
On Windows:

startMulticastSender.bat 225.4.5.6 5000

On UNIX:

startMulticastSender.sh 225.4.5.6 5000

5. Stop the execution of the multicast sender script. If there are any remaining nodes that were not
tested, repeat step 4 for them.

6. If you find that nodes are not receiving multicasts, repeat the multicast tests (step 3, 4, 5) with
other ports and/or addresses. In case of any problems, contact your network administrator to
make sure that the network is IP multicast enabled.

7. Once you know for which port and address (default or otherwise) the nodes are able to reach
each other via IP multicast, note these values to update the parameters in the configuration file
later.

To prepare the cluster:
1. Prepare the database system as explained in section Database Server Preparation on page 15
2. Install WebLogic Application Server on all computers that you want to include in your cluster. Use

the WebLogic installation instructions and the special instructions for configuring WebLogic in
section How to configure a WebLogic Domain for the Interstage BPM Server on page 17.

3. On the computer you have selected for your WebLogic Administration Server, perform the following
substeps:
a) Start the WebLogic Administration Server as instructed in section Starting WebLogic

Administration Server on page 19.
b) Configure the database, as explained in sections Copy database setup directory to database

machine on page 26 and Updating the database setup script on the database machine on
page 27.

c) Setup Interstage BPM Server. Use the instructions in chapter Setting-up Interstage BPM
Server and Console on page 21.
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Note: • Make sure that you specify the value for console_shared_root parameter in configuration
file during setup. Please ensure that the path specified in the value for this parameter is
accessible from all cluster member nodes.

• Ensure you do not use 'localhost' but the machine name or IP address in configuration
file during setup.

• This setup is only a dummy setup that is done for generating all the necessary files to
be used for the cluster set-up.

d) Make sure that Interstage BPM is operating correctly in a simple configuration i.e. running a
single Interstage BPM Server.

e) Stop the Interstage BPM Server.
f) Un-setup the dummy Interstage BPM Server setup. Refer Un-setup Interstage BPM Server

and Console on page 55.

You are now ready to configure a WebLogic cluster.

C.1.2 Configuring Environment Variables
To configure the required environment variables:
1. Edit the environment variable script located in <engine

directory>/server/deployment/WLS-Cluster:

Environment Variable ScriptOperating System

setIBPMenv.cmdWindows

setIBPMenv.shUNIX

2. Provide the appropriate values for the following variables:
• BEA_HOME=<WebLogic Installation Directory>

Location of your WebLogic installation directory.
Example on Windows: C:\Oracle\Middleware
Example on UNIX: /opt/oracle/middleware

• WEBLOGIC_SERVER_HOME=<WebLogic Installation Directory upto 'server' folder>
Path of the WebLogic installation directory upto the server folder.
Example on Windows: C:\Oracle\Middleware\wlserver\server
Example on UNIX: /opt/oracle/middleware/wlserver/server

• weblogic_domain=<Domain Name>
Name of the WebLogic domain that you created for Interstage BPM.
Example: InterstageBPM_domain

• DOMAIN_DIR=<Domain Directory>
Location of the domain directory.
Example on Windows: C:\Oracle\Middleware
\user_projects\domains\InterstageBPM_domain
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Example on UNIX:
/opt/oracle/middleware/user_projects/domains/InterstageBPM_domain

• IBPM_HOME=<engine directory>
Location of the engine directory.
Example on Windows: C:\engine
Example on UNIX: /opt/FJSVibpm/engine

• IFLOW_ROOT=<Interstage BPM Server default instance folder>
Location of the Interstage BPM Server default instance directory.
Example: <engine directory>\server\instance\default

While editing the setIBPMenv script, ensure you use only forward slashes (/) with any paths
in the script.

Note:

C.1.3 Configuring the Cluster
All of the WebLogic configurations performed to configure a cluster are performed on the computer
you have selected for your WebLogic Administration Server. This is the computer upon which you
setup Interstage BPM for WebLogic as a single server and got it running. You must continue to
connect to this computer to make any configuration changes.
You configure the cluster by running a script. The script setups the following components on the
cluster:
• JDBC
• Data Source
• JMS
• Interstage BPM Enterprise JavaBeans (EJBs)
• Startup Class
To configure an Interstage BPM Cluster on the WebLogic Administration Server computer:
1. Locate the following files in <engine directory>/server/deployment/WLS-Cluster:

• ibpmWLInstallScripts.properties

• ibpmWLInstallScripts.py

• On Windows: runWLScript.bat
• On UNIX: runWLScript.sh

2. If you want more than two servers in your Interstage BPM Cluster or want to change the names
of your servers or port numbers:
• Change the clusterServers parameter in the ibpmWLInstallScripts.py script.
• Change the NoOfServerInCluster parameter in the ibpmWLInstallScripts.properties

properties file as appropriate.
Make sure that the server names and port numbers are unique.
Example:
To add a server called InterstageBPMCS3 with port 49959 to the cluster configuration, change
the clusterServers parameter in the ibpmWLInstallScripts.py properties file to the following:
clusterServers={'InterstageBPMCS1':49952,'InterstageBPMCS2':49956,'InterstageBPMCS3':49959}
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Also, change the NoOfServerInCluster parameter in the ibpmWLInstallScripts.properties
properties file to the following:
NoOfServerInCluster=3

3. Run the cluster configuration script:

Cluster Configuration ScriptOperating System

runWLScript.bat <WebLogic Administrator Name> <WebLogic
Administrator Password> <Database User Name> <Database
User Password>

Windows

runWLScript.sh <WebLogic Administrator Name> <WebLogic
Administrator Password> <Database User Name> <Database
User Password>

UNIX

For <WebLogic Administrator Name> <WebLogic Administrator Password>, specify the
user account of the administrator for the WebLogic Administration Server.
For <Database User Name> <Database User Password>, specify the database user account
that you defined during setup of the Interstage BPM Server.
Running this script configures the cluster. It modifies the EJBs, JMS, database connections, etc.
to a cluster configuration.
If you did not modify the cluster setup files according to step 2 of this procedure, you now have
a cluster called InterstageBPMCluster and two WebLogic Managed Servers. The primary server
is named InterstageBPMCS1. Its port is 49952. The secondary server is named
InterstageBPMCS2. Its port is 49956.

4. Verify that the application server has been configured correctly. To do so:
a) Log in to the WebLogic Administration Console using the following URL:

http://<hostname>:7001/console

b) Go to <Domain> > Environment > Servers and verify that the servers have been created.
If you did not modify the cluster setup files, the primary server is named InterstageBPMCS1
and uses port 49952. The secondary server is named InterstageBPMCS2. Its port is 49956.

c) Go to <Domain> > Deployments and verify that an application called
InterstageBPMCServerApplication has been installed.

C.1.4 Configuring the Shared Resource Root
The ResourceRoot is a directory on a central server containing resources (such as workflow
applications, file listeners, shared classes, and so on).
In a load-balancing system, the ResourceRoot directory must be located on a central server that can
be accessed by all server nodes; all server nodes must use the same ResourceRoot directory.
Each server node must be configured to access the ResourceRoot directory on that central server.
The server nodes are allowed to map those directories to different physical paths as long as they
use the same symbolic name for the directory.
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If anonymous user access is not available to shared resource root, then make sure that
user who is starting the Server (each cluster server) have the following permissions to
access the configured shared resource root.

Note:

• For Windows:
• Directory, Sub-directories, and All files: Full control.

• For UNIX:
• Directory and Sub-directories: 'Read', 'Write' and 'Execute' permissions.
• All files: 'Read' and 'Write' permissions.

To configure your ResourceRoot:
1. On a central server, create a ResourceRoot directory.

Example: In the sample system, a file server is used to host the ResourceRoot directory. You
could create a directory named InterstageBPMShared.

2. Create the tenants/Default/ folders under the ResourceRoot directory.
For example, //MyFileServer/InterstageBPMShared/tenants/Default/

3. Do the following:
a) From the Weblogic Administration Server computer's <engine

directory>/server/instance/default/tenants/Default/ directory, move the following
folders to the tenants/Default/ folder under the ResourceRoot directory.
• apps

• attachments

• classes

• dmsroot

• lib

b) From any one of the server nodes, from <engine directory>/server/instance/default/,
move the search folder to the ResourceRoot directory (for example,
//MyFileServer/InterstageBPMShared/ ).

c) Copy the entire Interstage BPM structure from the Weblogic Administration Server computer
to the other computers in your cluster.
Example on Windows: If you accepted the default Interstage BPM location
C:\Fujitsu\InterstageBPM during setup, you would copy the Fujitsu directory and all of
its subdirectories from the WebLogic Administration Server computer svmd2 to the C: drive of
svmdapp5.
Example on UNIX: If you accepted the default Interstage BPM location /opt/FJSVibpm during
setup, you would copy the FJSVibpm directory and all of its subdirectories from the WebLogic
Administration Server computer svmd2 to the /opt directory of svmdapp5.
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Note: • In case of Horizontal cluster setup, the path of the Interstage BPM Server setup directory
must be the same on all computers in your cluster.

• In case of Vertical cluster setup, for node1 the copy directory is the BPM Environment.
For node2, follow these steps:
1. Create a folder as mentioned below:

• On Linux environment: /opt/FJSVibpm2/
• On Windows environment: C:\Fujitsu\InterstageBPM2\

2. In this folder, copy the entire contents of <engine directory>.
Note: The new folder structure created in the above step is the <engine directory>
for node2. While performing next steps, make sure you put the correct value.

4. On Windows, on each server node, update the <Path> tag of DmsCollections.xml file located
in <engine directory>/server/instance/default/tenants/Default/resources to specify
the attachments directory on the file server.
Specify the path for the DMS root directory to be a folder different from the default IBPM copy
directory and add share permissions to that folder.
Use one of the following formats to specify the directory's path:
//<Remote Computer Name>/<Absolute Path of DMS Folder>/

\\<Remote Computer Name>\<Absolute Path of DMS Folder>\

Example:

<DmsCollections>
<Dms>

<Path>//MyFileServer/InterstageBPMShared/tenants/Default/attachments</Path>

<ImplementationClass>com.fujitsu.iflow.dmsadapter.impl.FileSystemDmsSessionImpl

</ImplementationClass>
<Name>Attachments</Name>
</Dms>
</DmsCollections>

Note: • Do not use a network drive in the path specification. (For example, like in
<Path>P:/InterstageBPMShared/tenants/Default/attachments</Path>). Network
drives cannot be accessed by the Interstage BPM Server.

• In the path specification, if using the machine name does not work use the machine IP.

To use WebDAV directory as DMS, ensure that at least one File DMS directory (local path
folder) is present as the first DMS path in DmsCollections.xml.

Note:

5. Perform the subsequent steps if you are copying on the following operating system:
• UNIX
a) On each server node, create a directory (for example, /home/InterstageBPMShared) and

mount the ResourceRoot directory (for example, //MyFileServer/InterstageBPMShared)
that exists on the central server to this newly created directory.
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Note: • In case of horizontal cluster, path of the directory (for example,
/home/InterstageBPMShared) to which you mount the ResourceRoot directory, must
be the same on all server nodes in your cluster.

b) On each server node, mount the attachments directory that you copied on the file server.
c) On each server node, update the DmsCollections.xml file located in <engine

directory>/server/instance/default/tenants/Default/resources to specify the
attachments directory on the file server.

Example: If you mount the shared directory at mp1, you would update the DmsCollections.xml
file to look like the following:

<DmsCollections>
<Dms>
<Path>/mp1/attachments</Path>

<ImplementationClass>com.fujitsu.iflow.dmsadapter.impl.FileSystemDmsSessionImpl

</ImplementationClass>
<Name>Attachments</Name>

</Dms>
</DmsCollections>

To use WebDAV directory as DMS, ensure that at least one File DMS directory (local path
folder) is present as the first DMS path in DmsCollections.xml.

Note:

The DMS root directory's mount point may be different on the individual server nodes. However,
the directory's symbolic name, which is specified in the <Name> element, must be the same on
all server nodes. The following figure shows this configuration:

Figure 19: Sample DMS Configuration
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C.1.5 Updating the Interstage BPM Server Configuration Files
When you are running Interstage BPM Servers in a cluster, you must change some server
configuration settings to complete the cluster's server configuration.
To update the Interstage BPM Server configuration files:
1. On each cluster node, from the database, export out the server configuration settings into a

configuration file. Name the configuration file ibpm.properties, and place the configuration file
for that node at <engine directory>/server/instance/default.
Copy ibpm.properties file from <engine directory>/server/instance/default to <engine
directory>/server/deployment/WLS-Cluster directory.

Configuration Export ScriptOperating System

exportProperties.bat <filePath> <Database User Name>
<Password>

The script is located at <engine
directory>\server\deployment\bin\ directory.

Windows

exportProperties.sh <filePath> <Database User Name>
<Password>

The script is located at <engine
directory>/server/deployment/bin/ directory.

UNIX

Before you make any changes to the configuration file, create a copy of the configuration
file you exported as a back-up. In case you make errors while editing parameters and import
the file, Interstage BPM Server may not be able to start or errors may occur at runtime. In
such a case you can use the back-up file which contains a working configuration.

Note:

2. Add the following entries to the configuration file:

ServerName=<Name of the Cluster Server>
ServerSharedRoot=<Path of shared ResourceRoot in file server>

Example:
These are the entries on svmd2:

ServerName=InterstageBPMCS1
ServerSharedRoot=//MyFileServer/InterstageBPMShared/

Make sure that you specify the server names defined in the WLInstallScripts.py script
located in <engine directory>/server/deployment/WLS-Cluster.

Note:

3. On any one of the cluster nodes, add the following to the configuration file:

ServerInCluster=true

4. Update the following parameters in the configuration file on one of the cluster nodes. You must
have checked the default settings and noted the port and address (default or otherwise) the nodes
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are able to reach each other via IP multicast. Refer to the section Preparing the Cluster on page
84 for details.

ClusterMulticastPort=<Multicast Port Number>
ClusterMulticastTopic=<Multicast Group Address>

As the multicast parameters are identical for all cluster servers, you only need to add them
to the configuration file on one of the cluster nodes.

Note:

5. On each cluster node, ensure the values of the following node-specific properties are correct:
• JMSNamingProviderURL

• KPIListenerConfigFile

• ServerBaseURL

• ServerEmailBaseURL

• ServerHost

• ServerName

• ServerRoot

• JSExtCmdsFile

6. Before importing the configuration file to the database, delete the older system properties from
the database (from the IBPMProperties table) using the following SQL command:

DELETE FROM IBPMProperties WHERE tenantId = -1 AND modifier = 0

This step should be executed only on first cluster node of the same machine.Note:

In order for your changes to take effect, you will later import the updated configuration files into the
database.

C.1.6 Steps for Deploying Interstage BPM Console
Prerequisites: Admin Server for Weblogic Server Domain is running.

To deploy the Interstage BPM Console:
1. Create a directory (for example ibpmconsole) on your machine.
2. Copy console.war from the <engine directory>/client directory of your Interstage BPM

product media to the directory that you just created on your machine
3. Extract the files from console.war into the ibpmconsole directory. Use the following Java

command:
jar -xvf console.war

4. Delete the console.war file that you copied on your machine in step 2.
5. Copy iFlow.jar from <engine directory>/client/lib to WEB-INF/lib directory.
6. Login to the WebLogic Administration Console.
7. In the left pane of the Administration Console, click Deployments.
8. In the right pane, click Install. The Install Application Assistant page appears.
9. Click the link for Current Location and navigate to the ibpmconsole (where we have extracted

the console.war in Step 3) directory.
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10. Check the ibpmconsole checkbox. Then, click Next.
11. Make sure that the Install this deployment as an application checkbox is checked. Then, click

Next.
12. Check the InterstageBPMCluster checkbox in the Clusters list and click Next.
13. Select the I will make the deployment accessible from the following location option and click

Next.
14. Click Finish.

The console application will be deployed on the extracted location (ibpmconsole).

15. In case of horizontal cluster setup, you need to copy the extracted directory (ibpmconsole) on
all cluster nodes. The path to which you copy this directory must be same on all cluster nodes.

C.1.7 Steps for Deploying OpenID Provider
Prerequisites: Admin Server for Weblogic Server Domain is running.

To deploy the OpenID Provider:
1. Create a directory (for example openid) on your machine.
2. Copy openid.war from the <engine directory>/client directory of your Interstage BPM

product media to the directory that you just created on your machine.
3. Extract the files from openid.war into the openid directory. Use the following Java command:

jar -xvf openid.war

4. Delete the openid.war file that you copied on your machine in step 2.
5. Login to the WebLogic Administration Console.
6. In the left pane of the Administration Console, click Deployments.
7. In the right pane, click Install. The Install Application Assistant page appears.
8. Click the link for Current Location and navigate to the openid (where we have extracted the

openid.war in Step 3) directory.
9. Check the openid checkbox. Then, click Next.
10. Make sure that the Install this deployment as an application checkbox is checked. Then, click

Next.
11. Check the InterstageBPMCluster checkbox in the Clusters list and click Next.
12. Select the I will make the deployment accessible from the following location option and click

Next.
13. Click Finish.

The OpenID Provider application will be deployed on the extracted location (openid).

14. In case of horizontal cluster setup, you need to copy the extracted directory (openid) on all cluster
nodes. The path to which you copy this directory must be same on all cluster nodes.

C.1.8 Updating the Interstage BPM Client Configuration
Interstage BPM Server comes with a client configuration file, which is used by Interstage BPM Clients
to connect to the server. You need to update the client configuration file so that the client connects
to one of the cluster servers.
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To update the client configuration:
• On all computers in your cluster, update the following properties in the configuration file

iFlowClient.properties located in <engine directory>/client directory. Also, add these
properties in console.conf file only in <Console Shared Root> directory:
Here, <Console Shared Root> is the value of console_shared_root parameter set in the
configuration file during setup. For more information, refer to the section Preparing the Cluster
on page 84.
• JMSNamingProviderURL

• NamingProviderURL

Example:
These are the entries on svmd2 and svmdapp5:

JMSNamingProviderURL=t3://svmd2:49952,svmdapp5:49956
NamingProviderURL=t3://svmd2:49952,svmdapp5:49956

C.1.9 Updating Environment Variables and Server Startup Scripts
Scripts that start Interstage BPM Servers in single-server mode are currently on all of your cluster
computers. You must modify some environment variables to start the cluster servers instead of the
default Interstage BPM Server. Also, you must check whether the server startup scripts match the
host's environment.
To update environment variables and server startup scripts:
1. On the WebLogic Administration Server, change the SERVERNAME parameter to the name of the

primary server in the environment variable script.

Environment Variable ScriptOperating System

setIBPMenv.cmdWindows

setIBPMenv.shSolaris
Linux

The script is located in <engine directory>/server/deployment/WLS-Cluster.
Example:
This is the entry before the change: SERVERNAME=<Server Name Provided During Setup>

This is the entry after the change: SERVERNAME=InterstageBPMCS1

The server names to be used in a cluster are defined in the ibpmWLInstallScripts.py
script located in <engine directory>/server/deployment/WLS-Cluster.

Note:

2. On all other computers in the cluster, perform these steps:
a) Update the SERVERNAME and SERVER_HOST_NAME entries in the environment variable script.

Environment Variable ScriptOperating System

setIBPMenv.cmdWindows

setIBPMenv.shUNIX
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Example:
These are the entries on svmdapp5 before the change:
SERVERNAME=InterstageBPMServer

SERVER_HOST_NAME= svmd2

These are the entries after the change:
SERVERNAME=InterstageBPMCS2

SERVER_HOST_NAME=svmdapp5

b) Make sure that the JDBCPATH entry in the environment variable script is correct.
JDBCPATH specifies the path to the JDBC driver of the database you are using. The JDBC
driver must be copied from your database installation to a local directory on your computer.
For more information on the names of the JDBC driver files, refer to section Database Server
Preparation on page 15.

While editing the setIBPMenv script, ensure you use only forward slashes (/) with any paths
in the script.

Note:

3. On the WebLogic Administration Server and on all other computers in the cluster, make sure that
the paths specified in the server startup script and in the server shutdown scripts are correct.

Server Startup/Shutdown ScriptsOperating System

iFlowServer_Managed.bat

StopiFlowServer_Managed.bat

Windows

iFlowServer_Managed.sh

StopiFlowServer_Managed.sh

UNIX

The scripts are located in <engine directory>/server/deployment/WLS-Cluster.
Especially, verify the path to weblogic.jar and weblogic_sp.jar and the path to WebLogic's
server/bin directory.

C.1.10 Importing the Interstage BPM Server Configuration Files
Prerequisites:
• On each cluster node, you have updated the server configuration file as instructed in section

Updating the Interstage BPM Server Configuration Files on page 92.
• On each cluster node, you have updated the environment variables as explained in section

Updating Environment Variables and Server Startup Scripts on page 95.
• The database server is running.

To import the system configuration files into the database:
Execute the following steps on each node:
1. Open the script from the subdirectory that you created, for example from <engine

directory>/server/deployment/WLS-Cluster:
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Configuration Import ScriptOperating System

importProperties.bat <Database User
Name> <Password>

Windows

importProperties.sh <Database User
Name> <Password>

UNIX

For <Database User Name> and <Password>, specify the database user account that you defined
during setup of the Interstage BPM Server.

2. Replace <engine directory>/server/instance/default/ibpm.properties with
./ibpm.properties.
The script now references the ibpm.properties file that you copied to the <engine
directory>/server/deployment/WLS-Cluster.

3. Run the configuration import script.

If you update ClusterMulticastPort and ClusterMulticastTopic parameters, run the
configuration import script at the last on the cluster node where these properties are
configured. Otherwise these updated properties may get overwritten.

Note:

The script imports the configuration file you updated in section Updating the Interstage BPM Server
Configuration Files on page 92 into the database.
After import is complete, for security reasons, delete the configuration file on each node.

C.1.11 Starting the Cluster
Prerequisite: The Interstage BPM Cluster must be completely configured by following the clustering
appendix instructions through section Updating the Interstage BPM Client Configuration on page
94.

In case of WebLogic 12.1.1 and above, if JDK other than that is shipped with your application
server, is being used in iFlowServer_Managed.bat for starting Interstage BPM server,
then you need to copy the following directory to <JDK Home>/jre/lib/endorsed directory.

Note:

• For WebLogic 12.1.1: <MW_HOME>/wlserver_12.1/endorsed
• For WebLogic 12.1.3 and above: <MW_HOME>/oracle_common/modules/endorsed

To start the Interstage BPM cluster:
1. On each node, make sure that the WebLogic Administration Server is started by checking to see

that its Console Window is open and that the output <Server started in RUNNING mode> is
displayed.
If it is not started, you can start it in either of the following ways:
• Run the startup script provided by Interstage BPM in the <engine

directory>/server/deployment/WLS-Cluster directory:

Startup ScriptOperating System

startWebLogic.batWindows

startWebLogic.shUNIX
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• Run the startup script provided by Weblogic. For details, refer to section Starting WebLogic
Administration Server on page 19.

2. On each node, set the following JVM option in the startup script
(iFlowServer_Managed.bat\iFlowServer_Managed.sh) located in <engine
directory>/server/deployment/WLS-Cluster:
-DConsoleSharedRoot=<Console Shared Root>

Here, <Console Shared Root> is the value of console_shared_root parameter set in the
configuration file during setup. For more information, refer to the section Preparing the Cluster
on page 84.

3. On all cluster computers, start the Interstage BPM Server using the startup script provided by
Interstage BPM with the user who has access rights to <engine directory>(i.e. User who ran
the setup script).
This ensures that required environment variables are set before actually starting the server.

Server Startup ScriptOperating System

iFlowServer_Managed.bat <WebLogic Administrator Name>
<WebLogic Administrator Password>

Windows

iFlowServer_Managed.sh <WebLogic Administrator Name>
<WebLogic Administrator Password>

UNIX

You can start the cluster servers in any order.
If you are following the example, run the server startup script on svmd2 and svmdapp5.
Upon successful initialization of the server, the following output is displayed:

...
<Joining cluster InterstageBPMCluster on ...>
...
<Server started in RUNNING mode>

To confirm that each server has been started, on each server open Trace.log located at <engine
directory>/server/instance/default/logs and check that it contains the start up message.

... Interstage BPM Server Enterprise Edition Version <number> Build
<number> ... is ready ...

C.1.12 Automated Failover Settings
During operation, events are created and written to the database by each server node. Events are
tied to the server node that created them and will be processed by this server node. If a server node
goes down, and no failover is used, remaining events tied to this node will not be processed, and
the processing of such events will resume only when the server node is available again.
Automated failover (which is enabled by default) ensures that events that cannot be processed are
automatically transferred to other server nodes in the load-balancing system. Automated failover
settings are controlled using the following server properties:
• The ClusterAutomateFailoverEnabled server property. By default, this is true, which enables

automated failover.
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• The ClusterHeartbeatInterval property (which specifies how often the status of all nodes will
be checked) and the ClusterInterceptEvents property (which specifies, in case a node fails,
how many of unhandled events will be handled by the active nodes at a time).

For details about these properties and how to change them, refer the Interstage BPM Server
Administration Guide.

If the ClusterAutomateFailoverEnabled server property is set to 'true' before you start
all nodes in a cluster, the following behavior may occur (depending on the value of the
ClusterHeartbeatInterval property, and how long start-up of each node takes):
As you start nodes, each started node may begin handling any unhandled events of the
remaining, to-be-started nodes; this 'failover' will continue until all nodes have been started.
This is normal and expected behavior.

Note:

During failover, the order of transfer of unhandled events is as follows: first history events,
then timer events, and then events of process scheduler.

Note:

Example
This example demonstrates the processing of events in case one of two server nodes fails.
A sample load-balancing system with two server nodes has been set up. While all of the server nodes
are up and running, events are created and written to the database by each server node.

Figure 20: All Server Nodes are Up and Running
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If Node A goes down, events remain assigned to that node and are waiting to be processed.

Figure 21: Server Node Goes Down

If Node A goes down when automated failover is enabled:
• A pre-defined number (defined by the ClusterInterceptEvents server property) of node A's

unhandled events are transferred to Node B, and then processed by Node B.
• Then, depending on the value of ClusterHeartbeatInterval property, the next node status

check will be carried out.
• If node A is still found to be down, the next set from Node A's remaining events are transferred

to and processed by Node B.
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If node A continues to be down, the process described above continues until all of Node A's unhandled
events (one set at a time) have been transferred to and processed by Node B.

Figure 22: Events are Transferred to Another Node

C.1.13 Running Two Cluster Servers on the Same Computer (Optional)
Prerequisite: The database server is running.

To configure two cluster servers running on the same computer:
1. Prepare the cluster, configure environment variables, and configure the cluster as instructed in

sections Preparing the Cluster on page 84, Configuring Environment Variables on page 86, and
Configuring the Cluster on page 87.

2. Configure the shared resource root as instructed in sections Configuring the Shared Resource
Root on page 88.

3. From the database, export out the server configuration settings into a configuration file. Name
the configuration file ibpm.properties, and place the configuration file for that node at <engine
directory>/server/instance/default.
Refer to section Using the Configuration Export and Import Scripts on page 76 for details on how
to use the export script.

4. Copy ibpm.properties from <engine directory>/server/instance/default to the
subdirectory that you just created, for example to <engine
directory>/server/deployment/WLS-Cluster.

5. In the subdirectory that you created, update ibpm.properties file according to the steps 2-6
mentioned in the section Updating the Interstage BPM Server Configuration Files on page 92.

6. Deploy the Interstage BPM Console according to the instructions in section Steps for Deploying
Interstage BPM Console on page 93.
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7. Deploy the OpenID Provider according to the instructions in section Steps for Deploying OpenID
Provider on page 94.

8. In the environment variable script, change the SERVERNAME parameter to the server's name in the
cluster.
The script is located in the subdirectory that you created, for example in <engine
directory>/server/deployment/WLS-Cluster:

Environment Variable ScriptOperating System

setIBPMenv.cmdWindows

setIBPMenv.shUNIX

Example:
This is the entry before the change: set SERVERNAME=<Server Name Provided During Setup>

This is the entry after the change: set SERVERNAME=InterstageBPMCS1

The server names to be used in a cluster are defined in the ibpmWLInstallScripts.py
script located in <engine directory>/server/deployment/WLS-Cluster.

Note:

While editing the setIBPMenv script, ensure you use only forward slashes (/) with any paths
in the script.

Note:

9. Update the configuration import script. To do so:
a) Open the importProperties.bat/importProperties.sh script from the subdirectory that

you created, for example from <engine directory>/server/deployment/WLS-Cluster

b) Replace ../../instance/default/ibpm.properties with ./ibpm.properties.
The script now references the ibpm.properties file that you copied to the subdirectory.

10. Run the configuration import script as follows:

Configuration Import ScriptOperating System

importProperties.bat <Databse User
Name> <Password>

Windows

importProperties.sh <Databse User Name>
<Password>

UNIX

For security reasons, after importing the configuration file (ibpm.properties), ensure you delete
it.

11. Repeat steps 2 through 10 for each cluster server that you want to add. However, in case of
vertical cluster setup, step 6 and 7 are not required to repeat on each cluster node.
If you are following the example, repeat these steps to configure a second cluster server called
InterstageBPMCS2.

12. Update client configuration as described in section Updating the Interstage BPM Client
Configuration on page 94.

13. Start the Interstage BPM Server by running the startup script from the subdirectory that you
created, for example from <engine directory>/server/deployment/WLS-Cluster. Refer to
the section Starting the Cluster on page 97.
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C.1.14 Removing an Interstage BPM Cluster
To remove an Interstage BPM Cluster:
1. Log out of all Interstage BPM Clients and close all Browser windows.
2. Remove the Interstage BPM Console and OpenID Provider web applications using the steps

below:
a) Login to the WebLogic Administration Console, and in the left pane, click Deployments.
b) Select checkbox for ibpmconsole and click Delete.
c) Select checkbox for openid and click Delete.

3. In the ibpmWLInstallScripts.properties file located in <engine
directory>/server/deployment/WLS-Cluster, change the opType setting to the following:
opType=uninstall_cluster_ibpm

4. Run the cluster configuration script:

Cluster Configuration ScriptOperating System

runWLScript.bat <WebLogic Administrator Name> <WebLogic
Administrator Password> <Database User Name> <Database
User Password>

Windows

runWLScript.sh <WebLogic Administrator Name> <WebLogic
Administrator Password> <Database User Name> <Database
User Password>

UNIX

Running this script removes the Interstage BPM cluster from the application server.

5. Repeat the above steps on each cluster node.

The single-server setup of Interstage BPM is not modified by this procedure. If you want to remove
the single-server setup from the application server and un-setup the server software, follow the steps
explained in chapter Un-setup Interstage BPM Server and Console on page 55.
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Appendix D: Overview of NTLM Authentication Protocol
What is NTLM Authentication Protocol?
It is one of the security protocols used to authenticate users present in Windows AD network. The
users can login into the AD network via local or remote Windows workstations present within the AD
network. For more details regarding this protocol refer to Microsoft® documentation on NTLM.
Enabling NTLM Authentication Protocol for Interstage BPM Console
If you are accessing Interstage BPM Console on Windows, you can enable NTLM (NT LAN Manager)
Version1 authentication protocol for Interstage BPM Console.
Enabling this protocol allows Integrated Windows Authentication for Interstage BPM Console users
in a Microsoft AD network. For instance, if NTLM has been enabled for a tenant of Interstage BPM
and any user within that tenant successfully logs on to Windows desktop, then on accessing any
Interstage BPM Console URL of that tenant, user will be automatically logged in to Interstage BPM
Console without having to login to it explicitly; the Interstage BPM Console login screen will not
appear. However, login screen will always be displayed for Interstage BPM tenants who are not
configured for NTLM Authentication.
You can also enable NTLM based SSO Authentication by configuring IBPM tenant with OpenID
Provider module. For more details regarding this please refer the section Overview of SSO
Authentication on page 107.
Limitations:
• NTLM cannot be enabled for super users accessing the Interstage BPM Tenant Management

Console.
• NTLM authentication will only work if the machine on which Interstage BPM is being accessed

is on Microsoft AD network.
• Only NTLM Version1 is supported. NTLM Version 2 is not supported. (For NTLM authentication

via OpenID Provider NTLM Version 2 is also supported).
Prerequisites:
• Network: Machines being used for Interstage BPM Server and Console setup, and machines

being used to access the Interstage Console URL are present within the AD network.
• For all machines (Domain Controller, AD Clients, and Interstage BPM Server and Console

machine): Set Local Security Policy as described below:
Note: You must log on to Windows desktop using the Administrator's user ID.
1. Navigate to Start > Run, type gpedit.msc, click OK.
2. In the Local Group Policy Editor screen, go to Local Computer Policy > Computer

Configuration >WindowsSettings > Security Settings > Local Policies > Security Options
3. Update policies as mentioned below and click OK.

• Set policy Network security: LAN Manager authentication Level to Send NTLM
Response Only (for NTLM Version 1) or to Send NTLMv2 Response Only (for NTLM
Version 2, in case of NTLM via OpenID Provider).

Also, it is recommended to update following policies (if present) as mentioned below:
• Set policy Network security: Restrict NTLM: Incoming NTLM traffic to Allow all.
• Set policy Network security: Restrict NTLM: NTLM authentication in this domain to

Disable.
• Set policy Network security: Restrict NTLM: Outgoing NTLM traffic to remote servers

to Allow all.
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4. To apply these settings, navigate to Start > Run, type gpupdate, click OK.

• Setup: Interstage BPM Server and Console have been setup.
• AD Client Browser Setting: Enable Automatic logon in the Browser on Interstage BPM client

machine, as described below:
1. In the Web browser, navigate to Tools > Internet Options > Security > Internet > Custom

Level > User Authentication.
2. Select the Automatic Logon with current user name and password radio button to enable

this option.
3. Click OK.

If this option is not enabled, user will be prompted to enter the username and password. To
avoid this issue, in the browser, add the Interstage BPM Console address to local intranet
zone in Tools > Internet Option > Security > Local Intranet Zone > Sites.

Note:

D.1 Setup NTLM Authentication Protocol for Interstage BPM
Console
You have prepared the system environment as instructed in sectionOverview of NTLM Authentication
Protocol on page 104.

To setup NTLM Authentication Protocol, follow these steps:
For the steps to setup OpenID Provider for NTLM Authentication, refer the section Overview of SSO
Authentication on page 107.
Navigate to <Console Shared Root>/console/conf and add the following parameters (and their
values) to console.conf:
Here, <Console Shared Root> is the value of console_shared_root parameter set in the
configuration file during setup.
• SSONTLMTenants=<value1,value2>- this is a comma separated list of tenants for which you

want to enable NTLM.
Note: If you are specifying value in the SSONTLMTenants parameter, following parameters (except
SSOUserPassKey) are mandatory and should not be left blank. If you leave any of these parameters
blank, Interstage BPM Console will not start and an error will be logged in the Application Server
log file.

• SSOIP=<value> -the value is IP address of the domain controller (AD Server). This is a mandatory
parameter and should not be left blank.

• SSOPreAuthDomain=<value> -the value is the Domain Name (NETBIOS Name). This is a
mandatory parameter and should not be left blank.

• SSOPreAuthUser=<value> -the value is the Username of the Domain defined in SSOPreAuthDomain
parameter. This is a mandatory parameter and should not be left blank.

• SSOPreAuthPass=<value> -the value is the encrypted Password of the Domain user. This is a
mandatory parameter and should not be left blank.
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To encrypt the password, use the EncryptPassword.bat located in <engine
directory>/client/samples/configuration with the encryption key defined in the
SSOUserPassKey parameter. If no key is defined, then this script will use a default key to
encrypt the password.
For detailed information about encrypting passwords, please refer the section Password
Encryption on page 73.

Note:

• SSOUserPassKey=<value> -the value is the key to encrypt the password of the Domain user.
This is an optional parameter. If you do not specify, a default key will be used to encrypt the
password. This key should be 24 characters long.

The SSONTLMTenants parameter is dynamically reloadable, so if you add/modify/remove
this parameter, then you must log out and again login to the Interstage BPM Console for
the change to take effect. You do not need to restart the Interstage BPM Console.
However, if you add/modify/remove other parameters (i.e. SSOIP, SSOPreAuthDomain,
SSOPreAuthUser, SSOPreAuthPass, and SSOUserPassKey), then you must restart the
Interstage BPM Console.

Note:

For details about the Interstage BPM Console configuration file (console.conf) refer the Interstage
BPM Console Online Help.

When a machine's local user has logged-in into the AD Client machine and is trying to
access an NTLM Authentication enabled tenant, then the login screen will be displayed.
While providing credentials, if this user has clicked the Remember my password option,
the user name and password are stored in the Stored Username and Password utility of
the Windows. If any new user logs into the system and access the same URL, it will
automatically login with the previously stored user credentials. To solve this problem, you
need to remove the entry from the Windows utility as follows:

Note:

• For Windows Server 2008 and Windows Vista, remove the entry from:
Control Panel > User Accounts > Manage your network passwords > Stored User Names
and Passwords

• For Windows Server 2008 R2, Windows Server 2012, Windows Server 2012 R2,
Windows 7, Windows 8, Windows 8.1, remove the entry from:
Control Panel > All Control Panel Items > Credential Manager > Windows Vault/Windows
Credentials

Note: You must login as the Administrator user to complete this procedure.
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Appendix E: Overview of SSO Authentication
The SSO authentication process allows the user to log in once and gain access to multiple (SSO
enabled) applications without having to login again in each application during that session.
In this SSO authentication process, the authentication is performed by a single module referred to
as OpenID Provider application. Any application can leverage this SSO authentication process by
integrating with OpenID Provider. As a result, usage of a single authentication module removes the
overhead of authentication from each application & provides a centralized authentication mechanism
into which any number of applications can be integrated.
The OpenID Provider application makes use of the OpenID Authentication 2.0 protocol to
authenticate the users present in Microsoft Active Directory servers and Oracle Directory Server
Enterprise Edition. It is the central system where user authentication will be done for all web based
applications. You can configure this application for authentication of users in a particular directory
server.
The setup of OpenID Provider application is done automatically along with the setup of Interstage
BPM Server and Console for default tenant, if this tenant uses any directory server. If this tenant
uses Local User Management then OpenID Provider application will only be deployed but not
configured with any directory server, because OpenID Provider application does not support Local
User Management.
OpenID Provider Authentication Modes:
There are two types of authentication mechanisms supported by OpenID Provider. The type is
decided by OpenID Provider configuration property AuthType. Following are the authentication
modes:
• Authentication using Directory Server (LDAP): If AuthType configuration property value is

not NTLM (i.e. any value other than NTLM) then OpenID Provider will authenticate user using
LDAP protocol with help of other LDAP Configuration properties defined in OpenID Provider
configuration.

• Authentication using NTLM Protocol: If AuthType configuration property value is NTLM
(case-insensitive) then OpenID Provider will authenticate user using NTLM protocol. In this case
NTLM V1 or NTLM V2 is supported as an authentication protocol. For more details regarding
NTLM Protocol refer to the section Overview of NTLM Authentication Protocol on page 104.

Enabling SSO Authentication for Interstage BPM Console
If SSO authentication is enabled and you access the Console URL:
• If OpenID Provider is configured to use LDAP Protocol for authentication and you are accessing

the URL in a new session, the SSO login screen appears.
• If OpenID Provider is configured to use NTLM Protocol for authentication and you are accessing

the URL in a new session, then SSO login screen will not appear and you will be automatically
logged in to the Interstage BPM Console application.

• If you are already logged into an application that is pre-authenticated by SSO authentication
process, you will be automatically logged in to the Interstage BPM Console application in the
same session. The SSO Login screen will not appear. The Log Out link displayed in the header
of the Interstage BPM Console web page will also not appear. To log out, please close all the
browser windows.

For more information about enabling SSO authentication, refer to the sectionSetup SSOAuthentication
for Interstage BPM Console on page 108.
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E.1 Setup SSO Authentication for Interstage BPM Console
Pre-requisites:
• Interstage BPM OpenID Provider application is started.
• The tenant uses Microsoft Active Directory servers or Oracle Directory Server Enterprise Edition.

(The DirectoryService property of Interstage BPM Server Tenant must be set to 1 or 3).
• The OpenID Provider application and tenant both have the same LDAP configuration.
To use SSO authentication, follow these steps:

If you meet any of the following conditions, then before updating the SSO authentication it
is mandatory to update the OpenID Provider Configuration according to the instructions
given in the section Updating the OpenID Provider Configuration on page 108:

Note:

• If you specify the Local User Management during the setup of Interstage BPM.
• If the OpenID Provider application and tenant both have different LDAP configuration.
• If OpenID Provider needs to be configured to use NTLM authentication.

You can update the SSO authentication in following ways:
• Using the Interstage BPM Tenant Management Console: Select the tenant for which you want

to enable\disable the SSO authentication and update the SSOAuthentication property. For detail
instructions, refer to the SSOAuthentication section of Interstage BPM Server Administration
Guide.

E.2 Updating the OpenID Provider Configuration
To update OpenID Provider configuration, follow these steps:

If you use Built-in SSO authentication, do not include any forwardslash "/" or backslash '\'
characters in the user ID that you create.

Note:

1. Open the config.properties file located in the <Console Shared Root>/ssofi
/provider/<context-root-name>/ directory.
Here,
• <Console Shared Root>- is the value of console_shared_root parameter set in the

configuration file during setup.
• <context-root-name> - is the context-root name of the OpenID Provider application. Its value

is openid if you are using the OpenID provider application that is setup by the Interstage BPM
setup script.

2. Update the following parameters in this configuration file.

Any backslashes "\", colons ":" or equal signs "=" used in parameter values inside the
configuration file must be escaped by backslashes.
For example: C\:\\Program Files

Note:
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DescriptionMandatory?Parameter

The property decides which authentication
mechanism will be used by OpenID Provider
(either LDAP protocol or NTLM protocol).
• For LDAP Protocol AuthType=LDAP
• For NTLM Protocol AuthType=NTLM
This property is case-insensitive i.e. NTLM or
ntlm or nTLm is valid for NTLM Protocol. If there
is any other value then by default LDAP
protocol will be used for authentication. In case
of NTLM protocol, configuration properties
related to Directory Server are ignored (i.e. not
required).

YesAuthType

This parameter specifies the name of the
attribute that identifies the user ID within an
LDAP login string. The value of this parameter
can be any of the following:
• For Oracle Directory Server Enterprise

Edition: LDAPuid=uid

• For Microsoft Active Directory: LDAPuid=CN

YesLDAPuid

This parameter specifies the LDAP organization
unit to be used for searching users. Its value
will be:
For users stored in the Directory Service:
LDAPPeople=ou\=People

YesLDAPPeople

This parameter specifies the directory sub-tree
in the Directory Service where groups and users
to be used are stored. For example:
LDAPDBSuffix=dc\=xxx,dc\=fujitsu,dc\=com

The users will be searched under the
organization unit specified as the value of
LDAPPeople parameter.

YesLDAPDBSuffix
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DescriptionMandatory?Parameter

This parameter identifies the server (machine
name) on which the LDAP server is installed.
Its value will be in the following format:
LDAPServer=<PROTOCOL NAME>://<LDAP
SERVER HOST NAME/IP>:<PORT>

For example: LDAPServer=ldap\://<LDAP
Server FQDN>\:<port>

If LDAP is used in secured mode (i.e. LDAP
using SSL), then <PROTOCOL NAME> will be
ldaps and <PORT> value will be
<ldap-ssl-port>.
For example:
LDAPServer=ldaps\://<FQDN>\:<port>

YesLDAPServer

This parameter indicates the directory server
to be used for user authentication. Its value can
be:
• For Oracle Directory Server Enterprise

Edition:DirectoryService=1
• For Microsoft Active Directory:

DirectoryService=3

If you specify any other value, it will cause an
error.

YesDirectoryService

This parameter specifies the name of the LDAP
Context Factory class used to authenticate
users against a Directory Service. The initial
value is as mentioned below:
LDAPContextFactory=
com.sun.jndi.ldap.LdapCtxFactory

YesLDAPContextFactory

This parameter specifies the time duration after
which the connection to LDAP will be lost. The
value of this parameter is the time in
milliseconds. If this property is not specified, a
default value 30000 milliseconds will be used.
If it is left blank or an incorrect value (less than
Zero) is specified, it will cause an error.
LDAPConnectionTimeout=30000

NoLDAPConnectionTimeout

This parameter specifies the time duration (in
minutes) after which the session timeout will
occur. If the value is not specified or an
incorrect value is specified, a default value 1440
will be used. For example:
SessionTimeout=1440

NoSessionTimeout
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3. Restart the Interstage BPM OpenID Provider for the configuration property changes to take effect.
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Appendix F: Troubleshooting
F.1 Log File Information

For details about Log Files, refer the Configuring Log Files topic in the Interstage BPM Server
Administration Guide.

F.2 Resolving Specific Error Situations

F.2.1 Interstage BPM Server Fails to Start
Check the Error.log file in the <engine directory>/server/instance/default/logs directory.

What to doLook for

Check if the database is running. Also check that
you can access the database from the machine
where the Interstage BPM Server is setup in case
the database is running on a different machine.
You can use telnet <Database Server
Hostname> <Port> from the server host machine
to check that the connection to the database
host/port can be established.

DbService : setConnection: Connection to
database server failed. Is the database
server running and reachable through the
network? {ORA-01089: immediate shutdown
in progress - no operations are
permitted.

Ensure that the user name/password as specified
in the LDAPAccessUserID /
LDAPAccessUserPassword parameters of the
Interstage BPM Server are correct and you can
login to your Directory Server using the above
user name/password.

LdapBroker : getContext: Could not create
the directory services. {[LDAP: error
code 49 - Invalid Credentials]}

LdapBroker : getGroupMembersByDN: Could
not retrieve the user groups. {Could not
create the directory services. {[LDAP:
error code 49 - Invalid Credentials]}}

LdapBroker : Could not retrieve the user
groups. {Could not create the directory
services. {[LDAP: error code 49 - Invalid
Credentials]}}

Ensure that the LDAP Server is running on the
port as specified in the LDAPServer parameter
of the Interstage BPM Server. You can use
telnet ldapServerHostName port from the
server host machine to check that the connection
to the host/port can be established.

getContext: Could not create the
directory services.

LdapBroker : getGroupMembersByDN: Could
not retrieve the user groups. {Could not
create the directory services.

LdapBroker : Could not retrieve the user
groups. {Could not create the directory
services.

F.2.2 Error in Trace.log
Check the Trace.log in the <engine directory>/server/instance/default/logs directory.

Interstage BPM Server and Console Installation Guide (WebLogic Server) 112

Appendix F: Troubleshooting



What to doLook for

Possible cause of this error: A user has been
deleted from the Directory Server (LDAP Server)
but the reference of it is still there in one of the
groups.

getGroupMembersByDN: Could not retrieve
the user groups. {[LDAP: error code 32
- No Such Object]}

F.2.3 Timeout During JavaScript Execution
When executing large JavaScripts, the value for transaction timeout may be insufficient for the
following application server:
• WebLogic Application Server
Due to this setting, script execution may fail with a "transaction timeout".
Your application server administrator can increase the transaction timeout depending on your usage
requirements, for example, to 200 seconds. This setting can be changed in the following location:
• WebLogic Application Server: <jta>/<timeout-seconds>tag

in<MW_HOME>/user_projects/domains/<Domain Name>/config/config.xmlfile.
For Example: <jta><timeout-seconds>200</timeout-seconds></jta>

F.2.4 Failure in Writing to an Oracle Database
When the updating of an Oracle database table fails, for example, when you try to archive a process
instance, check the Oracle alert log file located in the <Oracle Installation Dir>/admin/<DB
instance name>/bdump directory, for example:
C:\ProgramFiles\Oracle\admin\orcl\bdump\alert_orcl.log

The following error may be observed:
{Database add/create request failed. {ORA-08103: object no longer exists}}

This failure may be due to the fact that the Datafile size reached the file size limit on the hard disk
of the database server.
The system administrator of the database server needs to increase the file size on the database
server hard disk.

F.3 Errors during Setup of the Interstage BPM Server
If you have trouble executing the setup script, you can check the cause of error by viewing
deployment.log. The deployment log is created at the following location:
On Windows: <engine directory>\server\deployment\logs\deployment.log

On Unix: <engine directory>/server/deployment/logs/deployment.log

The following tables explain the possible causes of errors during server startup and the appropriate
action(s) to take:

Setup of IBPM fails when trying to setup a new build

The build directory of the existing installed build was deleted, without un-installing
the build or un-installation failed.

CauseI
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Manually delete the earlier build's registry-entry, as follows:
1. Go to Start > Run, type regedit, click OK.
2. In the Registry Editor screen, go to below path.

• 32bit OS: HKEY_LOCAL_MACHINE > SOFTWARE > Fujitsu > Install >
Interstage BPM Server

• 64bit OS: HKEY_LOCAL_MACHINE > Wow6432Node > SOFTWARE >
Fujitsu > Install > Interstage BPM Server

3. Delete the Interstage BPM Server registry entry under Install key.
4. Go to below path.

• 32bit OS: HKEY_LOCAL_MACHINE > SOFTWARE >Microsoft >Windows
> CurrentVersion > Fujitsu > Interstage BPM Server

• 64bit OS: HKEY_LOCAL_MACHINE > Wow6432Node > SOFTWARE >
Microsoft >Windows > CurrentVersion > Fujitsu > Interstage BPMServer

5. Delete the Interstage BPM Server registry entry under Fujitsu key. This will
ensure complete deletion of the registry entry for Windows platform.

6. Go to below path.
• 32bit OS: HKEY_LOCAL_MACHINE > SOFTWARE >Microsoft >Windows

> CurrentVersion > Uninstall >
DFC70E37-68E7-469C-A253-9ED7BB3BCD23

• 64bit OS: HKEY_LOCAL_MACHINE > Wow6432Node > SOFTWARE >
Microsoft > Windows > CurrentVersion > Uninstall >
DFC70E37-68E7-469C-A253-9ED7BB3BCD23

7. Delete the Interstage Business Process Manager xx.x registry entry under
Uninstall key. This will ensure complete deletion of the registry entry for Windows
platform.

Action
(For
Windows)

Manually delete the Solaris package information, as follows:
1. Open the Command Prompt window and run the command pkginfo -l FJSVibpm

from any location of the Solaris machine, to check if the Solaris package
information still exists.

2. If the Solaris package information is displayed, then delete the package information
using the following steps:
a. Create a file named ibpm.uninst under the /tmp location.
b. Run the command pkgrm FJSVibpm to delete the Solaris package.
c. Run the command pkginfo -l FJSVibpm once more, to ensure that the

Solaris package has been deleted successfully. If no information is displayed,
then it confirms that the Solaris package has been completely deleted from
the Solaris platform.

Action
(For
Solaris)
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Manually delete the RPM package information, as follows:
1. Open the Command Prompt window and run the command rpm -qi FJSVibpm

from any location of the Linux machine, to check if the RPM package still exists.
2. If the RPM package information is displayed, then delete the package information

using the command rpm -e FJSVibpm.
3. Run the command rpm -qi FJSVibpm once more to ensure that the RPM package

has been deleted successfully. If no information is displayed, then it confirms that
the RPM package has been completely deleted from the Linux platform.

Action
(For
Linux)

An error occurred during Interstage BPM database creation/update

One of the following values provided during setup were wrong:
• Database Administrator user name
• Database Administrator password

CauseI

Restore the database from the backup of the database made before setting up
Interstage BPM.
Update the setup.config file and run the setup script again.

Action

One of the following values provided during setup were wrong:
• Host name of the database server
• Database SID (database instance name)
• Database port

CauseII

Restore the database from the backup of the database made before setting up
Interstage BPM.
Update the setup.config file and run the setup script again.

Action

Database server is not running.CauseIII

Start the database server.
Update the setup.config file and run the setup script again.

Action

Errors caused by JDBC Connection

The SQLRecoverableException occurs. This is caused by Oacle Bug 6485149.CauseI

Please contact Oracle Technical Support team for further instructions.Action

Errors caused by JDK Version

The version of JDK specified during setup does not match the version required for
this application server.

CauseI
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You need to update JAVA_HOME variable of system environment and run the setup
script again.
Please update JAVA_HOME with setIBPMJava.bat/setIBPMJava.sh that exists in
<engine directory>/server/deployment/bin when the error happens when the
script of Interstage BPM is executed after completing the setup.

Action

Problems related to LDAP Server Access

Even if LDAP server is up, the error message Unable to connect to specified
directory server appears. This happens when Super user or Tenant Administrator
is not registered in LDAP server.

CauseI

Please register the Super user and Tenant Administrator in the LDAP server before
executing the setup script.

Action

Errors Pertaining to Active Directory

The Active Directory Server is remote and Active Directory is not running.CauseI

Start the Active Directory Server, and then run the setup script again.Action

Interstage BPM cannot connect to the Active Directory Server because one of the
following values provided during setup was wrong:
• Active Directory Key
• Active Directory Organizational Unit

CauseII

Update the setup.config file and run the setup script again.Action

Errors Pertaining to Oracle Directory Server Enterprise Edition

Interstage BPM cannot connect to the LDAP Server because one of the following
values provided during setup was wrong:
• LDAP Key
• LDAP Organizational Unit

CauseI

Update the setup.config file and run the setup script again.Action

Errors Pertaining to Un-setup
For WebLogic Application Server:

Interstage BPM Un-setup failed.CauseI
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If un-setup fails, follow these steps to remove the resources:
1. Login to WebLogic Admin Console and navigate toDomain Structure > <Domain

Name>.
2. Check if the following resources exists and if exists then delete them.

• Navigate to Deployments and delete InterstageBPMServer and
InterstageBPMConsole applications, if exists.

• Navigate to Environment> Servers and delete IBPMServer, if exists.
• Navigate to Services > Messaging> JMS Modules and delete

InterstageBPM-JMSSystemResource.IBPMServer, if exists.
• Navigate to Services > Messaging> JMS Servers and delete

InterstageBPMJMSServer.IBPMServer, if exists.
• Navigate toServices >Data Sources and delete iflow.iFlowDS.IBPMServer,

if exists.
• Navigate to Services > XMLRegistries and delete ibpm_crimson_registry,

ibpm_sun_xerces_registry, and ibpm_xerces_registry if exists.

3. Delete the following directories manually from the file system:
• InterstageBPMServer directory located at <Weblogic

Home>/Middleware/user_projects/domains/<Domain
Name>/servers/AdminServer/upload/ directory.

• IBPMServer directory at <Weblogic
Home>/Middleware/user_projects/domains/<Domain Name>/servers/
directory.

Action

F.4 Errors Related to InterstageBPMDatabaseCreation/Update

Errors Pertaining to the Database

The Database Server is not running.CauseI

Start the Database Server, and then start the Interstage BPM Server.Action

Errors Pertaining to a Hostname Change

You changed the hostname of the computer where Interstage BPM Server has been
setup. As the hostname occurs in the names and values of various configuration
parameters of the Interstage BPM Server, the server cannot access its configuration
settings.

CauseI
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In the IBPMProperties table of the Interstage BPM database, make the following
changes:
• In the PROPERTYKEY column, update any parameter names that have the hostname

in the suffix.
These parameters have the format <PARAMETER_NAME>.<HOSTNAME> or
<PARAMETER_NAME>.<HOSTNAME>.<SERVERNAME>.

• In the PROPERTYVALUE column, update any parameter values containing the
hostname.

To update the IBPMProperties table, use the appropriate database commands or
a database client software.

Action

F.5 Contacting Your Local Fujitsu Support Organization
If you are unable to troubleshoot your problem:
1. Replicate the actions that caused the error.
2. Contact your local Fujitsu Support organization and provide the following information:

General Information
• Operating System
• Directory Service (type and version)
• Database server (type and version)
• JDK version
• Application server (type and version)
• Interstage BPM edition, version and build number
• Major problem area
• Priority of the issue
• Environment in which the problem occurs
Configuration Information
• The configuration file that you exported from the Interstage BPM Server
Log Files
• All log files from <engine directory>/server/instance/default/logs

• Setup log file from <engine directory>/server/deployment/logs/deployment.log

• When using WebLogic: All log files from <MW_HOME>/user_projects/domain/<Your
Domain>/servers/AdminServer/logs

OS System Logs
• The Windows event log that you obtain using the Windows Event Viewer
• Linux system logs stored in /var/log/messages

• Solaris system logs stored in /var/adm/messages

Problem Description
• Description of the steps you performed before the problem occurred
• Frequency with which the problem occurs
Problem Details
• The application program and its source code that caused the error
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• The XPDL file of the process definition that caused the error
• Information about Java Actions, Timers and Agents defined in the process definition
• Screenshot of the process instance history if the process instance goes into error state
• Stack trace if any exception is displayed

You can obtain the stack trace by clickingDetails on the error page displayed in the Interstage
BPM Console.

• Screenshot of the exception wherever it is displayed
• Screenshot of the process instance (graphical view) if the process instance goes into error

state or into an unexpected state
• Calendar files (*.cal) if timers are used
• The agentsConfig.xml file if agents are used
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